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Resumen 

En la fabricación de microprocesadores debe utilizarse una pasta llamada flux la cual 

libera de contaminantes los puntos de unión entre el dado de silicio y el sustrato, 

además de facilitar su conexión. 

Para el control de calidad del proceso es necesario detectar si existe un faltante o 

exceso de flux aplicado sobre los sustratos, por lo que frecuentemente se le realizan 

mediciones de espesor. Estas mediciones deberían ser reportadas con datos 

verdaderos. 

El método utilizado en la actualidad para la medición del espesor de flux no es 

confiable debido a que permite al operario manipular los datos obtenidos, realizar la 

medición en el lugar no adecuado o asignar valores sin ni siquiera adquirir los datos. 

Es por lo anterior que surge este proyecto el cual pretende disminuir los 

procedimientos manuales de la verificación del espesor de flux, que permita realizar 

la tarea de la medición de una forma confiable. 

Para ello, se propone desarrollar un control automático por medio de un motor y 

sensores que fije la posición para realizar la medición, y un sistema que permita 

adquirir los datos de la medición, los muestre a través de una interfaz gráfica, cree 

una base de datos y presente los resultados. 

 

Palabras claves: Medición de espesor, GPIB, interfaz gráfica, control de posición, 

motor, potenciómetro, código de barras, LabVIEW, etapa de potencia, tarjeta de 

adquisición de datos, base de datos, amplificador operacional. 

 



Abstract 

In the manufacture of microprocessors it is used a paste called flux, this paste 

liberates the attach points between silicon die and substrate from polluting agents; 

besides to facilitate the connection.  

To control the process quality it is necessary to measure the lack or excess of flux 

applied on substrates. These measurements should be reported with true data. 

The method used at the present time for the measurement of the flux thickness is not 

reliable because it allows the operator to: manipulate the obtained data, make the 

measurement in the incorrect place or assign values without acquiring the data. 

This project arises from the mentioned previously; it tries to diminish the manual 

procedures for flux thickness verification, allowing this measurement task to be done 

from a reliable method. 

Proposal is to develop an automatic control tool that measures the flux thickness on 

one single-correct position by using a motor-sensor system and a software interface 

that acquires, process and stores each measurement in a database and finally shows 

the data in a graphical interface. 

 

Keywords: Thickness measurement GPIB, graphical interface, position control, motor, 

potentiometer, bar code, LabVIEW, stage of power, data acquisition card, data base, 

op amp. 
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Capítulo 1  Introducción 

1.1 Problema existente e importancia de la solución 

El microprocesador o unidad central de proceso (siglas en inglés CPU de Central 

Process Unit), es un circuito electrónico microscópico que interpreta y ejecuta 

instrucciones. Generalmente consta de un trozo de silicio que contiene millones de 

componentes electrónicos denominado dado de silicio (en inglés die). 

Para aceptar órdenes del usuario, acceder a los datos y presentar los resultados, el 

microprocesador se conecta a los dispositivos de almacenamiento (como un disco 

duro), los dispositivos de entrada (teclado, ratón, etc.) y los dispositivos de salida 

(monitor, impresora, etc.). 

Para la conexión mecánica y eléctrica del dado con los dispositivos externos se 

utiliza el sustrato orgánico, necesario debido a que las conexiones del dado son muy 

pequeñas (entre 60 y 70 µm). El sustrato permite ampliar las conexiones para que se 

ajusten a los demás componentes a los que se debe conectar el microprocesador. La 

figura 1.1.1 muestra una vista transversal del dado y el sustrato. 

 
Figura 1.1.1 Vista transversal del sustrato y el dado. 

En el ensamble de microprocesadores, para la unión del dado al sustrato se aplica 

una pasta fina llamada flux sobre el sustrato, en la parte donde se va a colocar el 

dado. El flux es un componente químico y físicamente activo que, cuando se calienta, 

promueve la adherencia de soldadura fundida a una superficie metálica, además 

limpia las superficies a unir y remueve los óxidos que puedan evitar una buena unión. 
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Las uniones (o conexiones) entre el sustrato y el dado se forman cuando los puntos 

de soldadura del sustrato se funden y se adhieren a los puntos de soldadura del 

dado. Los puntos de soldadura en el dado están hechos de una aleación de plomo 

(Pb) y estaño (Sn) que tiende a formar óxidos a temperatura ambiente. Estos óxidos 

impiden el proceso reflujo (donde los puntos de soldadura fundida del 

microprocesador fluyen hacia los pines del sustrato) al requerir una temperatura más 

alta para fundir la capa de óxido y la soldadura, lo que puede causar un contacto 

eléctrico deficiente, así como una mala conexión mecánica [1]. 

Al ser ligeramente ácido, el material del flux ataca y rompe los óxidos formados en la 

superficie de los puntos de soldadura. Al remover los óxidos, el flux activa las 

superficies de la soldadura, mejorando el efecto de afinidad de las superficies a la 

soldadura e incrementa la acción de adherencia durante la etapa de reflujo. 

La viscosidad es otra propiedad importante del flux, ya que permite mantener el dado 

en la posición correcta durante la unión con el sustrato. La viscosidad es una medida 

de la fluidez (consistencia o espesor), disminuye (se hace más fluida) con el tiempo 

debido a la absorción de la humedad del aire. Al principio, el flux nuevo es más 

espeso y de alguna forma más difícil de controlar, por lo que la ejercitación del 

mismo es un método para volverlo más ralo, sin embargo, después de varias horas, 

el flux es demasiado ralo, lo que eventualmente hace que no sea utilizables en el 

proceso por lo que debe cambiarse [1]. 

Para garantizar el buen funcionamiento de esta fina pasta se realizan verificaciones 

del grosor (o espesor) de la capa de flux que es aplicada a los sustratos. 

La verificación se realiza en determinados momentos del proceso, por ejemplo, 

después antes de utilizar flux nuevo, después de cierto tiempo de uso o de 

inactividad. Consiste de cuatro mediciones en las posiciones estratégicas de una 

bandeja de las que se utilizan para transportar los sustratos durante el ensamble del 

procesador (ver figura 1.1.2). 
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Figura 1.1.2 Vista superior de una bandeja transportadora para 10 sustratos. 

Existen bandejas para 4, 8, 10 y 12 sustratos, la cantidad depende del producto, y las 

posiciones estratégicas para la medición del espesor de flux dependen de la bandeja, 

por ejemplo para una bandeja de 10 sustratos como la que muestra en la figura 1.1.2 

las posiciones son la 2, 5, 6 y 9. Lo que se procura es cubrir toda la bandeja sin 

necesidad de tener que realizar la medición en todas las posiciones. 

La medición de espesor de flux se realiza por medio de un dispositivo que calcula y 

muestra en una pantalla el espesor de un objeto o material que se coloca entre dos 

sensores de distancia conectados al dispositivo, posee una mesa corrediza que 

permite llevar el objeto a los sensores. La figura 1.1.3 muestra un dibujo de este 

dispositivo y en el anexo B.1 se presentan fotografías de este. 
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Figura 1.1.3 Dispositivo medidor de espesor. 
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Para la medición se utilizan unas piezas (llamadas cupones) metálicas con las 

mismas dimensiones de un sustrato. El objetivo de estos cupones es simular el 

sustrato pero con las superficies lisas para una mejor medición, pues las medidas 

son en milésimas de pulgada (mils) y cualquier irregularidad puede variar la medida, 

por lo tanto también se especifica que la medición siempre se dirija al centro del 

cupón en el lugar donde estará impreso el flux y que todo se encuentre 

completamente limpio. 

Limpiar bien los cupones, la bandeja transportadora, los sensores y la mesa 

corrediza, colocar los cupones en la bandeja en las posiciones correspondientes y 

completar la bandeja con sustratos, son los pasos que inician el procedimiento de 

verificación de espesor de la capa de flux que es aplicada sobre los sustratos. Los 

pasos siguientes se describen más fácilmente a través del diagrama de flujo de la 

figura 1.1.4 y figura 1.1.5. 

Este procedimiento esta sujeto a que se ejecute de mala manera lo cual lo hace no 

muy confiable. El diagrama de bloques de la figura 1.1.6 explica la forma en que por 

lo general se realiza la verificación de espesor. 
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Lleve la bandeja al 
dispositivo medidor y 

posicione un cupón en la 
mesa corrediza

Posicione el centro del 
cupón debajo del sensor del 

dispositivo medidor

¿Centro del cupón bajo 
el sensor?

No

Programe el dispositivo 
medidor para que tome este 

valor como referencia

Sí

¿Lectura del dispositivo 
igual a 0?

No

Remueva el cupón y 
coloquelo en la bandeja 

transportadora

Sí

Posicione el centro del 
cupón debajo del sensor del 

dispositivo medidor

¿Centro del cupón bajo 
el sensor?

No

Sí

Anote el valor mostrado por 
el dispositivo medidor, 

tomando en cuenta el signo

¿Ultimo cupón?

No

 Coloque el siguiente cupón 
en la mesa corrediza

Remuva el cupón y 
coloquelo en la bandeja 

transportadora

A

Sí

Inicio

Objeto: Ancho medido
Lectura: Lo que muestra el dispositivo medidor
EspC: Espesor del cupón
Ref: Valor programado al dispositivo medidor
Nota: Las unidades de los datos son en 
milésimas de pulgada.

Ejemplo:
     Objeto                      Lectura        
EspC2=43.229    EspC2-Ref=-0.008
EspC3=43.310    EspC3-Ref=0.003
EspC4=43.315    EspC4-Ref=0.008.

Ejemplo:
         Objeto                     Lectura     
EspC1=43.307=Ref    EspC1-Ref=0

 
Figura 1.1.4 Primera parte diagrama de flujo para la verificación del espesor de flux. 
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Imprima el flux sobre la 
bandeja transportadora con 

los cupones.

A

¿Se manipuló el punto 
de referencia del 

dispositivo?

Asegurase de que el 
dispositivo medidor no es 
manipulado mientras se 

continua el procedimiento

Limpie la bandeja 
transportadora y los cupones 

metálico

Inicio

Sí

Lleve la bandeja al mismo 
dispositivo medidor donde se 

realizaron las primeras 
mediciones

No

Posicione el centro del 
cupón debajo del sensor del 

dispositivo medidor

Anote el valor mostrado por 
el dispositivo medidor, 

tomando en cuenta el signo

Remuva el cupón y 
coloquelo en la bandeja 

transportadora

¿Ultimo cupón?

Coloque un cupón en la 
mesa corrediza

Sí

Introduzca los datos 
obtenidos en el software 

especializado.

¿Espesor del flux 
dentro del rango 

permitido?

Este software se encarga de 
realizar la resta entre los datos 
obtenidos después y antes de 
aplicar el flux y almacenarlos. 
La resta corresponde al espesor 
del flux. 

Realice el procedimiento de 
búsqueda y solución del 

problema 

Continúe el proceso de 
ensamble del dado al 

sustrato

SíNo

Es muy importante que no 
se pierda el punto de 

referencia que se programó 
al dispositivo medidor.

Ejemplo:
                       Objeto                                              Lectura             
EspC1+EspF1=43.307+0.900=44.207    EspC1+EspF1-Ref=0.009
EspC2+EspF2=43.299+1.000=44.299    EspC2+EspF2-Ref=0.992 
EspC3+EspF3=43.310+0.850=44.160    EspC3+EspF3-Ref=0.853
EspC4+EspF4=43.315+1.050=44.365    EspC4+EspF4-Ref=1.058

Ejemplo:
                      Software
PostF1-PreF1=0.009-0=0.009
PostF2-PreF2=0.992-(-)0.008=1.000 
PostF3-PreF3=0.853-0.003=0.850
PostF4-PreF4=1.058-0.008=1.050

PostF:Medición después de la 
aplicación de flux

PreF:Medición antes de la 
aplicacion de flux

 
Figura 1.1.5 Continuación diagrama de flujo para la verificación del espesor de flux. 
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Se imprime el flux sobre la 
bandeja transportadora con 

los cupones.

Inicio

Se lleva la bandeja al 
dispositivo medidor de flux

Se posiciona una zona del 
cupón donde NO posea flux 

debajo del sensor del 
dispositivo medidor

Se coloca un cupón en la 
mesa corrediza

No

Se programa el dispositivo 
medidor para que tome este 

valor como referencia

¿Lectura del dispositivo 
igual a 0?

No

Sí

Se posiciona una zona del 
cupón donde posea flux 

debajo del sensor del 
dispositivo medidor

Se anota el valor mostrado 
por el dispositivo medidor

Se remuve el cupón y se 
coloca en la bandeja 

transportadora

¿Ultimo cupón? Sí

Se introducen los datos 
obtenidos en el software 

especializado

¿Espesor del flux 
dentro del rango 

permitido?

Realice el procedimiento de 
búsqueda y solución del 

problema 

Continúe el proceso de 
ensamble del dado al 

sustrato

SíNo

 
Figura 1.1.6 Diagrama de flujo de la forma en que el operario realiza la verificación del 

espesor de flux. 
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Los principales problemas que se han detectado de la forma en que los operarios 

realizan la verificación de espesor del flux se enumeran a continuación. 

1. Se programa la referencia del dispositivo medidor en cada cupón después de 

aplicado el flux, sobre una zona donde no se aplica flux. El principal problema es que 

no se garantiza que el cupón sea completamente uniforme y debido a que las 

medidas son en milésimas de pulgada (mils) cualquier irregularidad en la superficie 

del cupón por más pequeña que sea puede variar la medición. Por eso es que se 

pide que la medición se haga siempre en el mismo sector del cupón (en el centro) 

por lo que la referencia se debe programar solo sobre el primer cupón y antes de 

aplicar el flux. La figura 1.1.7 muestra el efecto de programar la referencia del 

dispositivo medidor después de imprimir el flux. 

 
Figura 1.1.7 Efecto de programar la referencia del dispositivo medidor de espesor antes y 

después de imprimir el flux.  

2. La medición sobre el flux se realiza en un lugar arbitrario con tal de obtener el 

valor requerido. Por lo general, hacia los bordes del flux aplicado el valor del espesor 

es mayor que en el punto central. La figura 1.1.8 ilustra el resultado de tomar la 

medición en el borde del flux. 

 
Figura 1.1.8 Efecto de realizar la medición sobre el centro y el borde de flux. 
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3. Se han detectado ocasiones en que el operario realiza la medición solamente 

sobre un cupón y asigna el mismo valor o uno parecido a los demás. 

4. También se ha descubierto que se alteran (cambian) los datos brindados por 

el dispositivo de medición que se encuentran fuera del rango permitido, a la hora de 

ingresarlos al software. 

Esta mala práctica a la hora de realizar la verificación del espesor de la capa de flux 

aplicado para la conexión del dado de silicio al sustrato, es la principal causa de 

pérdida de producto por desalineamiento del dado (ver figura 1.1.9), mala conexión 

entre el dado y el sustrato (ver figura 1.1.10) y/o corto circuito (debido a impurezas en 

la zona de conexión), todas debidas ya sea al exceso o falta de espesor de flux. 

 
Figura 1.1.9 Ejemplos de desalineamiento del dado.  

 
Figura 1.1.10 Ejemplo de mala conexión entre el dado y el sustrato. 

Este proyecto pretende desarrollar un sistema que evite la manipulación de los datos 

y ejecute la medición de forma correcta. 

Dentro de los beneficios que se derivan de resolver este problema están los 

siguientes: 

1. Mayor confianza en el procedimiento de verificación de espesor de flux. 

2. Disminución de las pérdidas de producto debidas al mal funcionamiento del flux. 

3. Menor operación de los controles del dispositivo de medición. 

4. Agilización del proceso de verificación. 
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1.2 Solución seleccionada 

Debido a la importancia del flux en el ensamble de procesadores, se requiere que el 

proceso de verificación de espesor de la capa aplicada a los sustratos se ejecute de 

forma correcta y eficaz. Por tanto se pretende diseñar un sistema capaz de cumplir 

con las siguientes necesidades. 

1. Proveer la información de una forma que pueda ser verificable y no 

manipulable. 

2. Realizar la medición en el momento y lugar adecuado. 

3. Efectuar la medición sobre los cuatro cupones. 

4. Identificar cuándo los valores de la medición se encuentran fuera de rango. 

5. Almacenar la información en archivos con un formato accesible para posterior 

análisis. 

Para cumplir con los requerimientos anteriores y darle solución al problema actual del 

proceso de verificación, se desarrolla un sistema basado en una herramienta 

computacional diseñada mediante el lenguaje LabVIEW1. La figura 1.2.1 muestra el 

diagrama de bloques general de la solución. 

Aplicación 
Desarrollada 
en Labview 

para el 
Proceso de 

Verificación de 
Espesor de 

Flux

Resultado de Medición

Historial del Procedimiento
Posición Requerida

Posicionamiento del Cupón 

Leer del Dispositivo 

Punto de Referencia

Información del Proceso

Parámetros de Medición

Lectura de Espesor

Cupón en Medición

Posición Actual
 

Figura 1.2.1 Diagrama de bloques general de la solución. 
                                                 
1  Lenguaje de programación gráfica que utiliza iconos en vez de líneas de texto para crear 

aplicaciones [2]. 
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Las entradas y salidas del sistema se explican a continuación. 

Entradas: 

Información del proceso: 

Se refiere básicamente a las variables relacionadas al procedimiento de verificación 

tales como usuario encargado (nombre, número de identificación y turno), fecha, 

hora, lugar (línea de producción), producto y el motivo de la verificación.  

El objetivo de introducir esta información es tener un mayor control del 

procedimiento, facilitar el análisis y entendimiento de los datos de espesor obtenidos 

y determinar el origen o la causa de algún problema concerniente al espesor del flux. 

Previamente se introduce (por personal autorizado) en una base de datos las 

posibles opciones en cuanto a usuario, producto, línea y motivo de verificación. El 

usuario debe seleccionar la información correspondiente a través de una interfaz 

gráfica antes de proceder a realizar las mediciones de espesor. 

Parámetros de medición: 

Están directamente relacionados al producto, y se refieren al rango permitido para los 

valores del espesor del flux (límite superior e inferior). 

Estos valores se utilizan para determinar si los datos obtenidos del espesor durante 

el proceso de verificación son los apropiados para continuar con el ensamble de 

procesadores. 

Cuando se ingresa el producto a la base de datos se le asignan los respectivos 

parámetros de la medición. Así que una vez que el producto es seleccionado por el 

usuario como información del proceso, los parámetros de medición son introducidos 

automáticamente. 

Lectura de espesor: 

Es la lectura que realiza el dispositivo medidor de espesor la cual se envía a la 

aplicación por medio de una interfaz de comunicación adecuada entre el dispositivo 
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medidor y la computadora que conforma el Sistema de Comunicación que se explica 

más adelante. 

Posición requerida: 

Es la posición en la que se debe situar el cupón para capturar el dato de la medición 

de espesor, es decir cuando el centro del cupón se encuentra bajo los sensores del 

dispositivo medidor. 

Es ingresada y ajustada por personal autorizado a través de la aplicación en 

LabVIEW y es parte del Sistema de Control de Posición el cual se explica más 

adelante. 

Posición actual: 

Se refiere a la señal que indica la posición en la que se encuentra el cupón en 

medición. 

Cuando la posición actual es igual a la posición requerida significa que se puede 

realizar la medición de espesor. Esta señal se obtiene del Sistema de Control de 

Posición. 

Cupón en medición: 

Es una señal que indica cuál de los cuatro cupones que corresponde al proceso de 

verificación es el que se encuentra en medición. 

Garantiza que la medición se realiza sobre los cuatro cupones y que existe 

correspondencia entre la medición anterior y posterior a la impresión del flux, en el 

momento de calcular el espesor. 

Esta señal se genera a través del sistema denominado Sistema Identificación de 

Cupón el cual también se explica más adelante. 
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Salidas: 

Resultado de Medición: 

Una vez que se han ingresado las mediciones de espesor antes y después de 

imprimir el flux, el programa calcula automáticamente el espesor de la capa de flux, 

el promedio y la desviación estándar de estos y además indica si se encuentran 

dentro del rango permitido para continuar con el ensamble de procesadores. 

Historial del procedimiento: 

La aplicación almacena en una base de datos la información del proceso y los 

resultados de la medición y los muestra en forma de tabla y gráficas, facilitando algún 

tipo de investigación o análisis del caso. 

Posicionamiento del cupón 

Es una señal de control encargada del mecanismo que posiciona el cupón en el lugar 

correcto para la medición. Este mecanismo es la base del Sistema de Control de 

Posición. 

Leer del dispositivo: 

Es una serie de comandos que se envía automáticamente al dispositivo medidor para 

que envíe las lecturas de espesor hacia la computadora. 

Al igual que la salida “punto de referencia”, esta forma parte del Sistema de 

Comunicación. 

Punto de referencia: 

Es la serie de comandos que se envían automáticamente al dispositivo medidor para 

programarle el punto de referencia en el momento adecuado. 
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Del sistema de la figura 1.2.1 conformado por la aplicación en LabVIEW, se derivan 

tres sistemas los cuales ya han sido mencionados anteriormente, estos son el 

Sistema de Comunicación, el Sistema de Control de Posición y el Sistema 

Identificación de Cupón. Seguidamente se hace una breve explicación de cada uno 

de estos y posteriormente en el capítulo 5 se explican con más detalle. 

Sistema de Comunicación: 

Cosiste en interconectar el dispositivo de medición a una computadora por medio de 

una interfaz de comunicación adecuada. En la figura 1.2.2 se muestra en diagrama 

de bloques el sistema. 

Lectura de Espesor

Leer del Dispositivo 

Punto de Referencia

Computadora Dispositivo 
Medidor

 
Figura 1.2.2 Diagrama de bloque del Sistema de Comunicación. 

El objetivo de este sistema es tener control sobre el instrumento de medición y sobre 

todo capturar los datos de la medición  

Sistema de Control de Posición: 

Se basa en un sistema de control automático en lazo cerrado tal como se muestra en 

la figura 1.2.3. 

Posición Actual

Posición Requerida Computadora Posicionamiento del Cupón 
Planta 

(Motor y 
Sensor)

 
Figura 1.2.3 Diagrama de bloque de Sistema de Control de Posición. 
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Consiste de una nueva mesa corrediza que permite fijar el cupón, un motor acoplado 

a la mesa corrediza y un sensor que detecta la posición de la mesa. Su objetivo es 

tener control sobre la ubicación del cupón. 

Sistema Identificación de Cupón: 

Consiste en marcar los cupones y en un lector de la marca que envía la información 

hacia la computadora, en la figura 1.2.4 se ilustra en diagrama de bloques este 

sistema. 

Cupón en MediciónComputadora Lector de la 
Marca

 
Figura 1.2.4 Diagrama de bloques de la etapa 3 de la solución. 

 

A continuación se presenta en el capítulo 2 los objetivos que se pretenden alcanzar 

con el desarrollo del proyecto. En el capítulo 3 (Marco Teórico) se describe el 

proceso que se desea mejorar con el desarrollo de este proyecto así como los 

principales temas relacionados con la solución del problema tales como interfaces y 

software de comunicación y control automático. En el capítulo 4 se presenta el 

proceso metodológico seguido para llegar a la solución del problema. El capítulo 5 

hace una explicación detallada del diseño de la solución implementada. En el 

capítulo 6 se presentan los resultados de la verificación del funcionamiento del 

sistema y el análisis correspondiente que evidencian el alcance de los objetivos y 

especificaciones planteadas. Finalmente en el capítulo 7 se incluyen las principales 

conclusiones, (beneficios o consecuencias) obtenidas como producto de la solución 

del problema resuelto mediante el proyecto. 
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Capítulo 2  Meta y Objetivo 

2.1 Meta 

Disminuir en un 50% las pérdidas de producto por falta o exceso de la capa de flux 

aplicada sobre el sustrato. 

2.2 Objetivo General 

Automatizar el proceso de verificación del espesor del flux para garantizar que los 

datos recolectados sean verídicos. 

2.3 Objetivos Específicos 

2.3.1 Objetivos de Hardware 

Diseñar y realizar un sistema que permita comunicar el dispositivo de medición de 

espesor con la computadora. 

Plantear e implementar un sistema para asegurar el posicionamiento del cupón en el 

lugar correcto para realizar la medición. 

Desarrollar un sistema capaz de identificar el cupón metálico sobre el cual se 

realizará la verificación del espesor de flux. 

2.3.2 Objetivos de Software 

Crear un programa que capture, muestre y evalúe los datos de medición y la 

información general del proceso. 

Desarrollar un programa que controle el sistema de posicionamiento del cupón. 

Realizar un programa que controle el sistema de identificación del cupón. 

2.3.3 Objetivos de documentación 

Elaborar un manual sobre el manejo del sistema desarrollado. 
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Capítulo 3  Marco teórico 

3.1 Descripción del proceso a mejorar 

3.1.1 Proceso del Módulo de Unión de Chips (CAM) 

Debido al tamaño tan pequeño (de 80 a 110 mm2) de los microprocesadores, y por 

ende a lo diminuto de sus conectores (de 60 a 70 µm), se debe emplear un elemento 

que facilite el manejo de las señales para la integración de otros componentes. 

El elemento empleado es el sustrato orgánico, el cual es una tableta diseñada para 

proveer conexiones mecánicas y eléctricas entre el dado de silicio del 

microprocesador y el panel de circuitos de la computadora. 

El Módulo de Unión de Chips (siglas en inglés CAM de Chip Attach Module) es 

donde se une el dado al sustrato. La operación de este módulo consiste de tres 

operaciones principales: aplicación de flux, colocación del dado y adhesión del dado. 

Además, se encarga de colocar componentes pasivos como capacitores y 

resistencias a los productos que lo requieren. En este caso, se dan dos procesos 

adicionales que introducen la impresión de pasta de soldadura y la colocación de los 

componentes en el sustrato que rodean el dado. 

Un ejemplo de los productos que requieren componentes pasivos son los 

microprocesadores para servidores, mientras que los que no los requieren se pueden 

mencionar los microprocesadores para computadoras portátiles y de escritorio. 

La figura 3.1.1 muestra el flujo del proceso completo en la operación del módulo de 

unión de chips. 

Impresión de 
Flux

Impresión de 
Pasta de 

Soldadura

Colocación 
Componentes 

Pasivos

Colocación 
Dado de 

Silicio

Unión por 
Reflujo

 
Figura 3.1.1 Flujo del proceso de unión de chips. 

Una vez que los sustratos son colocados en las bandejas transportadoras se 

descargan por medio del sistema de manejo de materiales a la impresora de flux 

 17



para la impresión. Los rollos de cinta transportadora que sostienen el dado se cargan 

en la máquina que coloca el dado en el sustrato, y cuando se requieren componentes 

pasivos los rollos de cinta transportadora que sostienen estos componentes se 

cargan en la máquina encargada de su colocación. 

El flux es dispensado a través de una placa metálica conocida como esténcil, con 

cortes con la forma del dado. Este se coloca sobre el substrato de tal manera que la 

parte de la impresora que distribuye el flux sobre el esténcil (squeegees) sólo aplica 

flux en el área del substrato en el que las unidades van a ser colocadas [3]. La figura 

3.1.2 muestra este procedimiento. 

 
Figura 3.1.2 Proceso de dispensado de flux. 

Después de un cambio de cartucho de flux, mantenimiento preventivo a la máquina 

(PM), cambio de producto, cambio de esténcil o cada vez que se enciende la 

máquina, se debe realizar una revisión del espesor de flux. Esta revisión se realiza 

con el medidor de espesor sin contacto como el que se observa en la figura 3.1.3. 

 
Figura 3.1.3 Medidor de espesor sin contacto modelo CL-250. 

Después del dispensado de flux, el sistema de transporte lleva los sustratos a la 

segunda impresora automática con esténcil para impresión de la pasta de soldadura. 
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Si el producto requiere de componentes pasivos, esta segunda impresora aplicará 

pasta de soldadura en los sustratos como lo muestra la figura 3.1.4. Sin embargo, si 

el producto no necesita componentes pasivos, la impresora de pasta se ajusta 

entonces para pasar solamente por el modo sin imprimir. 

 
Figura 3.1.4 Proceso de aplicación de pasta de soldadura. 

Seguidamente el sustrato se transporta hacia la herramienta encargada de colocar 

los componentes. Esta recoge los componentes pasivos que se encuentran en los 

rollos de cinta transportadora, verifica la alineación y el tamaño de los componentes, 

y compensa para permitir una colocación precisa en la orientación correcta sobre los 

pines de soldadura en el sustrato [3], como lo muestra la figura 3.1.5. 

 
Figura 3.1.5 Proceso de montaje de componentes pasivos. 

Igualmente, se lleva los sustratos a una máquina que posee cámaras para verificar 

que el dado esté alineado con el sustrato. Por medio de una cabeza de recolección 

se recoge el dado del rollo de cinta transportadora y se coloca en el substrato [3] 

como se observa en la figura 3.1.6. 

 
Figura 3.1.6 Proceso de colocación del dado en el sustrato. 
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Después de la colocación del dado en el sustrato, se pasa por un sistema de revisión 

por medio de cámaras conocido como DPCS (significado en inglés Die Placement 

Checking System), que vigila la colocación del dado para detectar unidades 

desalineadas [3]. 

Luego el dado y sustrato se llevan al horno de convección de reflujo, una faja lleva 

los materiales a través de las zonas de calentamiento y enfriamiento. Cuatro zonas 

de calor crean un perfil térmico que hace que los pines de soldadura del substrato 

refluyan con los puntos de soldadura del dado y se unan. Esto crea una conexión 

eléctrica entre el dado y el substrato. De la misma manera para el producto con 

componentes pasivos [3]. Este procedimiento se refleja en la figura 3.1.7. 

 
Figura 3.1.7 Proceso de fundición para la unión del dado  al sustrato. 
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3.1.2 Medición de espesor de flux por medio del Ono-Sokki 

Como se menciona en el capítulo 1, el flux es un material que se utiliza para la 

conexión del dado de silicio con el sustrato en la fabricación de procesadores. 

Debido a su característica de viscosidad se debe verificar cada cierto tiempo el 

espesor de la capa que se aplica sobre el sustrato para garantizar su buen 

funcionamiento. 

El procedimiento que se emplea para la revisión se describe a continuación. Primero 

que todo se debe verificar que los sensores del dispositivo medidor tengan un 

espacio máximo de 1 milímetro con respecto al material a medir. Para lograrlo se 

debe centrar el cupón metálico entre los sensores superior e inferior como lo muestra 

la figura 3.1.8 [3]. 

 
Figura 3.1.8 Sensor capacitivo para medir distancias. 

Ya una vez ajustados los sensores se colocan los cupones y los sustratos sobre la 

bandeja transportadora en las posiciones correspondientes, ya establecidas para 

cada producto. La figura 3.1.9 muestra un ejemplo para bandejas de 12 posiciones 

donde los cupones se colocan en las posiciones 3, 6, 7 y 10 de la bandeja [3]. 
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Figura 3.1.9 Bandeja transportadora de 12 posiciones completado con cupones y sustratos. 

Después que se realiza la impresión de flux, se retira el cupón metálico, se limpia 

cuidadosamente la parte de abajo de este y se coloca en la mesa corrediza de la 

base de los sensores del dispositivo medidor de espesor, bien centrado entre los 

sensores. 

La lectura del espesor del flux se observa en la pantalla del dispositivo medidor y los 

valores obtenidos se registran manualmente por el operario en una base de datos. 

Los datos registrados no deben ser modificados con respecto a los obtenidos del 

medidor de espesor, pues esto podría causar problemas en el proceso de ensamble, 

por ejemplo al registrar un valor que se encuentre dentro de los límites previamente 

establecidos cuando en realidad el valor obtenido se encontraba fuera de estos 

límites. 

Solamente se puede continuar con el proceso de ensamble si los valores de espesor 

están dentro del rango permitido. Si estos se encuentran fuera del rango se debe 

completar un procedimiento extra de respuesta a la falla. 
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3.2 Descripción de los principales principios físicos de software y 
electrónicos relacionados con la solución del problema 

Esta sección pretende introducir las características principales del dispositivo 

medidor de espesor en cuanto al puerto y la forma de comunicación, y estudiar las 

opciones de interfaces y software para conectase y tener control del dispositivo 

desde una computadora. Además se presentan algunos conocimientos básicos sobre 

control automático y posibilidades de equipo para sensar y controlar la posición de la 

mesa corrediza desde la computadora. También se estudian las diferentes formas de 

identificar los cupones. 

3.2.1 Interfaces de comunicación 

• Bus de Interfaz de Propósito General (GPIB) 

El dispositivo medidor de espesor cuenta con el bus de interfaz de propósito general 

(siglas en inglés GPIB de General-Pourpose Interface Bus) como interfaz de 

comunicación estándar. Este fue desarrollado por Hewlett-Packard en 1965 donde 

obtuvo el nombre de HP-IB, sin embargo fue tanta su adopción en la industria que el 

Instituto de Ingenieros Eléctricos y Electrónicos (en inglés IEEE, Institute of Electrical 

and Electronics Engineers) lo convirtió en el estándar 488, a partir del cual han 

surgido el 488.1 y el 488.2 donde las velocidades van desde 1.5 Mbytes/s hasta 8 

Mbytes/s. Fue diseñado específicamente para la comunicación de instrumentos de 

medición, principalmente permite transferir los datos de la medición y tener un control 

remoto del dispositivo desde una computadora. Esto se logra mandando comandos 

propios a los instrumentos que estructuran las órdenes para que respondan a los 

pedidos realizados [4]. En la figura 3.2.1 se muestra la distribución eléctrica. 
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Figura 3.2.1 Distribución de señales del puerto GPIB. 

Consta de 24 pines, repartidos de la siguiente forma: 

• 8 líneas de transmisión de datos (DIO1-DIO8) 

• 3 líneas para el control asíncrono de la comunicación (NRFD, NDAC y 

NRDAV). Mediante estas líneas se verifica la correcta transmisión de los 

datos. 

• 5 líneas que gestionan la transmisión de comandos (ATN, IFC, REN, SRQ y 

EOI). 

• El resto de pines componen las tierras de las diferentes líneas. 

Para poder comunicarse con el dispositivo desde una computadora existen  tarjetas 

de interfaz insertables para los buses tradicionales como el PCI 2 . Y además 

productos de enlace o controladores externos que permiten convertir de GPIB a otro 

tipo de bus como por ejemplo USB, Ethernet, RS-232 o FireWire, 

                                                 
2 PCI de Peripheral Component Interconnect, es un bus local estándar en computadoras 

personales. 
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• USB 

El puerto USB fue diseñado inicialmente para conectar dispositivos periféricos a la 

PC, tales como teclados, escáners, unidades de disco. Con el paso de los años, el 

número de dispositivos que incorporan la conectividad USB se ha incrementado 

dramáticamente en la industria de las computadoras. 

Con la especificación USB 1.1, el rendimiento alcanza hasta los 1.5 Mbytes/s y con la 

especificación USB 2.0 se amplia el desempeño del bus hasta 60 Mbytes/s. Además, 

la especificación USB 2.0 asegura la compatibilidad con los dispositivos USB 1.1 e 

incluso utiliza el mismo conector. Debido a que USB es una tecnología de conectar y 

utilizar (plug & play), la computadora automáticamente detecta cuando un nuevo 

dispositivo ha sido agregado, obtiene su identificación y configura los manejadores 

(drivers) apropiadamente. Hasta 127 dispositivos se pueden conectar de manera 

concurrente en un puerto [4]. 

A pesar de que USB tiene muchos beneficios atractivos, existen algunas desventajas 

para su uso en el control de instrumentos. Primero, los cables USB no son para uso 

industrial, lo cual potencialmente permite pérdida de datos en ambientes ruidosos. 

Por otra parte, no existe un mecanismo de cierre para los cables USB, pueden ser 

desconectados de la PC o del instrumento relativamente fácil. La longitud máxima del 

cable en los sistemas USB es de 30 m, incluyendo el uso de repetidores. Finalmente, 

no hay un protocolo industrial diseñado para el control de instrumentos vía USB; esto 

requeriría implementación individual por parte del fabricante del instrumento. 

A pesar de las desventajas de USB, la amplia disponibilidad de puertos en las 

computadoras de hoy en día y la alta velocidad con USB 2.0, hacen que sea 

considerado una opción para el control de instrumentos. 

• Ethernet 

A pesar de que Ethernet es nuevo en las aplicaciones de control de instrumentos, es 

una tecnología que es ampliamente utilizada para sistemas de medición. 
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Las aplicaciones de control de instrumentos con Ethernet pueden tomar ventajas de 

las características únicas del bus, las cuales incluyen control remoto, facilidad para 

compartir los instrumentos entre usuarios, y una fácil publicación de los datos 

obtenidos. Por otra parte, se puede tomar ventaja de las extensas redes Ethernet 

existentes en las compañías y laboratorios.  

Otros factores a considerar al examinar Ethernet para el control de instrumentos, son 

la velocidad de transferencia y seguridad. La mayoría de las redes Ethernet de hoy 

en día son del tipo 10BaseT ó 100BaseTX, las cuales transmiten datos a 10 Mbytes/s 

ó 100 Mbytes/s respectivamente. Sin embargo, estas tasas de transferencia son 

teóricas debido a factores como: tráfico en la red, retrasos e ineficiencia en la 

transferencia de datos. Por otra parte, debido a la incertidumbre en las tasas de 

transferencia, no se puede asegurar un determinismo en la comunicación a través de 

Ethernet [4]. 

• FireWire 

El estándar IEEE 1394-1995, también conocido como FireWire es un bus serial de 

alto desempeño originalmente desarrollado por Apple en los años 80. Actualmente, 

IEEE 1394 puede alcanzar velocidades de desempeño de hasta 50 Mbytes/s. La 

especificación 1394 señala que los dispositivos deben de estar dentro de 4.5 m del 

conector del bus y que hasta 16 dispositivos pueden ser conectados en serie con una 

longitud máxima de 72 m [4]. 

El bus 1394 tiene un gran potencial para aplicaciones de alta velocidad. El gran 

ancho de banda que involucra a las aplicaciones multimedia hace que 1394 sea una 

solución viable. 

3.2.2 Software de comunicación 

Para lograr comunicar y controlar el dispositivo medidor con una computadora se 

debe desarrollar un programa utilizando un lenguaje de programación adecuado que 

logre la comunicación entre dichos instrumentos. A continuación se mencionan 

algunos software empleados para la comunicación con GPIB. 
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• Programas propietarios 

La primera alternativa, es el uso de software propietario desarrollado por los mismos 

fabricantes del instrumento. 

La ventaja evidente de estos programas es que pueden ser empleados con solo 

conectar los instrumentos, y proporcionan las funciones más comunes que se puede 

realizar, sin necesidad de programar. 

Las desventajas son también claras: por tratarse de software cerrado, sólo puede ser 

usado para la tarea para la que fue diseñado, y además son imposibles de integrar 

con otros programas.  

• LabVIEW 

Usando LabVIEW para las aplicaciones de medición y automatización se puede 

adquirir datos al conectarse con varios dispositivos, definir una aplicación para 

analizar o tomar decisiones en base a esos datos y después presentar los datos por 

medio de interfaces gráficas, páginas Web, archivos de bases de datos y más. 

LabVIEW es un ambiente de desarrollo gráfico con funciones integradas para realizar 

adquisición de datos, control de instrumentos, análisis de mediciones y 

presentaciones de datos [2]. 

A diferencia de los lenguajes de propósito general posee herramientas para crear 

aplicaciones sin líneas de texto de código: se colocan objetos ya construidos para 

crear interfaces de usuario, después se especifica la funcionalidad del sistema 

armando diagramas de bloques. Esto permite construir los sistemas más 

rápidamente [2]. 

Permite la comunicación con hardware de medición, desde cualquier tipo de 

instrumento autónomo tales como GPIB, VXI, PXI, RS-232, Ethernet, USB, FireWire, 

dispositivos de adquisición de datos, controladores de movimiento y sistemas de 

adquisición de imágenes. Incluye funciones específicas para adquisición de datos, 

control de instrumentos, análisis de mediciones, presentación y guardado de datos. 
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• Matlab 

Matlab fue en su origen un conjunto de rutinas para manipulación de matrices, pero 

ha evolucionado con el tiempo para convertirse en un entorno de programación de 

propósito general con potencia matemática y aplicabilidad en ciencia e ingeniería 

gracias a sus módulos de extensión de procesamiento de señales, control, 

ecuaciones diferenciales entre otros. 

Recientemente, cuenta una línea de ampliación hacia la conexión de hardware con la 

computadora, distribuyendo módulos para el control de tarjetas de adquisición, 

generación de código y emulación de control remoto de computadoras para 

operación en tiempo real, adquisición de imágenes, etc. 

3.2.3 Sistema de Control de Posición  

Para colocar el cupón metálico en el lugar adecuado en el momento de la medición 

de espesor sin necesidad de intervención humana, se debe implementar un control 

automático por medio de sensores que detecten la posición y un motor que mueva la 

mesa corrediza del medidor de espesor sobre la cual se coloca el cupón. Además se 

debe desarrollar un compensador que permita ajustar el sistema de modo que logre 

un comportamiento dinámico deseado en cuanto al tiempo de estabilización y 

sobreimpulso, y un controlador estático adecuado esto en cuanto al error de estado 

estacionario y rechazo de perturbaciones. 

Control Automático 

El control automático permite alcanzar y mantener la posición deseada midiendo el 

valor de la posición actual del cupón por medio de sensores y comparándolo con el 

valor deseado. 

La principal característica de un sistema de control automático es el lazo de 

realimentación ya que éste es el que permite comparar la salida del sistema con la 

entrada, con el fin de establecer una acción de control apropiada. La figura 3.2.2 

muestra el esquema de un sistema de control. 
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Figura 3.2.2 Diagrama de un sistema de control automático. 

La señal de salida (y) es la variable que se desea controlar. 

La señal de referencia (r) es la meta de la señal de salida. 

La señal de error (e) es la diferencia entre la señal de salida y la de referencia. 

La señal de control (u) es la que produce el controlador para lograr que la señal de 

salida alcance la de referencia. 

Para el diseño de controladores es necesario conocer la función de transferencia de 

la planta a controlar, es decir la relación entre la entrada y salida del sistema en 

función de transformadas de Laplace (para sistemas continuos) o trasformadas zeta 

(para sistemas discretos). 

Con la ayuda de herramientas computacionales y una tarjeta de adquisición de datos 

se puede calcular la función de transferencia alimentando el sistema con una entrada 

escalón y obteniendo la respuesta a la salida del sistema. 

A partir de la respuesta al escalón se puede obtener las especificaciones en el 

dominio del tiempo que se define como [5]: 

1. Tiempo de retardo (td): tiempo en el cual la respuesta al escalón va de 0 al 

50% de su valor final 

2. Tiempo de levantamiento (tr): tiempo en el cual la respuesta al escalón va del 

10 al 90% de su valor final. 

3. Tiempo pico (tp): tiempo en el cual la respuesta al escalón alcanza el valor 

máximo. 

4. Tiempo de estabilización (ts): tiempo en el cual la respuesta al escalón alcanza 

su estado estable. 
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5. Sobrepaso máximo (mp): Es el valor máximo alcanzado por la respuesta al 

escalón tomando como base su valor en estado estable. 

Un método que facilita el análisis de sistemas que utilizan motor de corriente 

continua es aproximar la función de transferencia a la de un sistema prototipo de 

segundo orden, lo cual generalmente ayuda al análisis de sistemas de orden 

superior. La función de transferencia en lazo abierto para este tipo de sistema 

prototipo es representada por la ecuación (3.2.1) [5]. 
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Donde: 

nw =frecuencia natural no amortiguada. 

ζ =Factor de amortiguamiento relativo. 

La función de transferencia en lazo cerrado por consiguiente es: 
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Las raíces de la ecuación característica de un sistema de segundo orden se pueden 

expresar como: 

 2
21 1, ζζ −±−= nn jwwss           (3.2.3) 

En la figura 3.2.3 se muestra la localización de las raíces de la ecuación 

característica en el plano s. 

 
Figura 3.2.3 Localización de las raíces de la ecuación característica en el plano s. 
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Para el cálculo del factor de amortiguamiento relativo y de la frecuencia natural no 

amortiguada se parte de la relación con el sobrepaso máximo (mp) y el tiempo pico 

(tp) la cual se muestra en las ecuaciones siguientes: 
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De la ecuación (3.2.4) se despeja el ζ dando como resultado la ecuación (3.2.6), y 

una vez que se obtiene el factor de amortiguamiento se puede calcular a partir de 

la ecuación (3.2.7) que resulta al despejar la ecuación (3.2.5). 
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Un sistema se puede clasificar con respecto al factor de amortiguamiento relativo 

como [5]: 

1. Bajo amortiguamiento ( 10 << ζ ) 

2. Amortiguamiento crítico ( 1=ζ ) 

3. Sobre amortiguamiento ( 1>ζ ) 

4. No amortiguamiento ( 0>ζ ) 

5. Amortiguamiento negativo ( 0<ζ ) 

A partir de la función de transferencia se diseña el controlador que permita alcanzar 

las especificaciones deseadas en cuanto al sobrepaso máximo y tiempo de 

estabilización. 
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Existen varios tipos de controladores como son el proporcional (P), integral (I), 

derivativo (D) proporcional integral (PI), proporcional derivativo (PD) y proporcional 

integral derivativo (PID). 

El control proporcional (P) es básicamente un amplificador con ganancia ajustable, la 

característica de este controlador es que al aumentarse la ganancia el sistema 

responde más rápido pero se hace más oscilatorio. La ecuación (3.2.8) muestra la 

relación entrada-salida de este tipo de controlador. 

)()( teKtu p ⋅=            (3.2.8) 

Kp es la ganancia, u(t) en la señal de control en función del tiempo y e(t) es la señal 

de error del sistema en función del tiempo. 

El controlador integral (I) hace que la señal de control varíe con respecto a la integral 

de la señal de error tal como se observa en (3.2.9). 

∫⋅−= dttektu i )()(            (3.2.9) 

ki es la ganancia del control integral. 

Este tipo de controlador tiende a eliminar el error de estado estacionario del sistema, 

pero con un dimensionamiento incorrecto puede causar inestabilidad. 

El controlador con acción derivativa (D) disminuye las oscilaciones al anticiparse al 

error, pero no puede usarse solo ya que no responde a un error en estado estable. 

En la ecuación (3.2.10) se observa que la corrección es proporcional a la derivada de 

la señal de error. 

dt
tdektu d
)()( ⋅=          (3.2.10) 

kd  es igual a la ganancia del control derivativo. 

Los controladores PI, PD y PID son la combinación lineal de los controladores 

anteriormente mencionados (P, I y D) sus ecuaciones son la suma de las ecuaciones 

de las respectivas combinaciones. 
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Matlab es una herramienta computacional que facilita el análisis de sistemas de 

control, en el anexo B.2 se presentan algunos comandos empleados. 

3.2.4 Sensores de posición 

En los sistemas de control los sensores cumplen la función de convertir la variable 

física que se desea controlar en una magnitud eléctrica (voltaje, corriente, 

resistencia, etc.) 

La variable a controlar en este proyecto es la posición del cupón metálico en la mesa 

corrediza del dispositivo medidor de espesor, para asegurar que se encuentre en el 

lugar correcto en el momento de la medición. A continuación se explican algunos 

tipos de sensores de posición que pueden ayudar para el desarrollo del proyecto [6]. 

El interruptor de límite es un dispositivo mecánico que utiliza contacto físico para 

detectar la presencia de un objeto. Sus ventajas son la capacidad para alta corriente 

y bajo costo. Las desventajas son que requiere de contacto físico con el objeto, son 

de respuesta muy lenta y producen rebotes. 

El Sensor Inductivo está constituido por un circuito oscilador con alta frecuencia de 

resonancia, que crea un campo electromagnético para detectar la presencia de 

objetos metálicos. Cuando un metal entra al campo electromagnético causa una 

carga sobre el sensor atenuando la amplitud del campo electromagnético. La 

detección de dicha amplitud permite obtener la señal que indica la presencia o no del 

objeto. Las ventajas que presenta son la resistencia a ambientes agresivos, larga 

vida y fáciles de instalar, mientras que sus desventajas son que la distancia es 

limitada y solo se utiliza para sensar materiales metálicos. 

El Sensor Capacitivo es similar al sensor de proximidad inductivo. La principal 

diferencia entre los dos tipos es que el capacitivo produce un campo electrostático en 

lugar de un campo electromagnético, por lo que puede detectar objetos no metálicos 

(como vidrio, cerámica, plástico, madera, agua, aceite, cartón, papel, etc.), pero su 

desventaja es que es muy sensible a cambios extremos del ambiente. 
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El Sensor Ultrasónico utiliza ondas sonoras para detectar la presencia de objetos. 

Cuando un objeto interrumpe el haz de sonido el nivel de recepción varia y el 

receptor lo detecta. La ventaja de este es que puede detectar todos los materiales, 

hasta transparentes. La desventaja es la sensibilidad al cambio de temperatura. 

El Sensor Fotoeléctrico utiliza un rayo de luz modulado que es bloqueado o reflejado 

por un objeto. Sus ventajas son que sensa toda clase de materiales, posee larga 

vida, es inmune a perturbaciones electromagnéticas, la distancia de detección es 

grande, posee una alta velocidad de respuesta, identifica colores y detecta pequeños 

objetos. 

El Potenciómetro lineal es un dispositivo que si en sus terminales fijas se aplica un 

voltaje producirá en su terminal variable un voltaje equivalente a su posición. Entre 

sus ventajas, se puede determinar la posición en cualquier momento es decir no solo 

detecta la presencia del objeto, es facilidad de implementar y el costo es muy bajo. 

Sin embargo requiere de contacto físico con el objeto. 
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Capítulo 4  Procedimiento metodológico 

En este capítulo se describe la metodología empleada para el reconocimiento del 

problema y la implementación de la solución. 

4.1 Reconocimiento y definición del problema 

En una primera etapa para lograr la identificación exacta del problema se 

identificaron y analizaron las etapas del proceso de verificación de espesor del flux, 

considerando las tareas, los participantes y los insumos del proceso. Posteriormente, 

a través de entrevistas a los operarios del sistema actual, fue posible identificar las 

necesidades o problemas que éstos enfrentan y también las deficiencias del proceso. 

Dichas necesidades y deficiencias fueron validadas a través de pruebas con el fin de 

delimitar mejor el alcance y facilitar la definición de los requerimientos y restricciones 

del proyecto. Dichos requerimientos y limitaciones fueron especificados y revisados 

junto con los supervisores de la empresa. 

4.2 Obtención y análisis de información 

Como parte del desarrollo de la solución del proyecto se realizó adecuadamente un 

proceso de obtención y análisis de la información recolectada. El primer paso para 

llevar a cabo la obtención de los datos fue investigar el funcionamiento del dispositivo 

de medición mediante el manual de usuario del mismo. Posteriormente para el 

planteamiento de la solución y desarrollo del sistema fue necesario investigar sobre 

los métodos de análisis y evaluación del comportamiento de un sistema de control, 

además determinar las características que deben poseer las partes mecánicas del 

sistema y las modificaciones que se deben realizar a la estructura del dispositivo de 

medición para adaptar el sistema a implementar. 

Para realizar la preparación del dispositivo de solución o sistema a implementar se 

llevaron a cabo experimentos para determinar el comportamiento real del sistema, 

determinar las características de la interfaz gráfica e investigar sobre los tipos de 

controladores y la forma como se implementan para obtener el comportamiento 

requerido del sistema. Además se hicieron investigaciones en Internet sobre las 

 35



opciones de dispositivos y software para el desarrollo del sistema y posteriormente 

consultar a expertos sobre la mejor opción de estos. Finalmente para hacer una 

selección de los materiales a utilizar se solicitaron cotizaciones a distribuidores y 

fabricantes y mediante un cuadro comparativo de los aspectos investigados se hizo 

la selección de la mejor alternativa. 

4.3 Evaluación de las alternativas y síntesis de una solución  

En las etapas finales del proceso, para obtener una síntesis de la solución se analizó 

la información del cuadro comparativo para evaluar las alternativas investigadas 

tomando como parámetros de comparación el costo de la oferta, la capacidad del 

equipo y la facilidad de implementación. Para apoyar la decisión sobre la selección 

de la alternativa adecuada se hicieron consultas al personal correspondiente sobre la 

posibilidad de obtener el equipo y finalmente considerando esto y los criterios 

especificados se seleccionó la mejor opción. 

4.4 Implementación de la solución 

Una vez definida la mejor alternativa como solución inició el proceso de 

implementación de la misma, dicha implementación abarcó una serie de tareas a 

desarrollar. En un inicio del desarrollo del sistema se interconectó el dispositivo de 

medición de espesor a la computadora a través de una interfaz de comunicación, 

luego se desarrolló un programa que capturara y mostrara los datos obtenidos con el 

dispositivo de medición de espesor y otro que enviara comandos de instrucciones a 

éste dispositivo. Una de las funciones más importantes del sistema es el 

posicionamiento del cupón para la medición por lo que las tareas siguientes fueron 

diseñar el sistema de control de posición y el sistema identificador del cupón a 

implementar, coordinar la construcción e instalación de las partes mecánicas del 

sistema y calibrar el equipo para controlar la posición del cupón. Una vez construido 

el dispositivo se determinaron los algoritmos y se desarrolló el programa para el 

control de posición del cupón, posteriormente se hizo una comprobación del 

funcionamiento de dicho programa. En la parte final de la implementación del sistema 
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se instaló y calibró el equipo para la identificación del cupón medido. Luego para el 

almacenamiento de los datos se desarrolló un programa para que los datos de la 

medición se registren en el espacio correspondiente al cupón medido. Después de 

hacer la comprobación del funcionamiento del sistema se desarrolló la interfaz 

gráfica que controlara cada parte del sistema. 

4.5 Reevaluación y rediseño 

La última parte consistió en optimizar el sistema y realizar cambios a la interfaz 

gráfica según sugerencias de los operarios del sistema. 
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Capítulo 5  Descripción detallada de la solución 

El sistema desarrollado para la corrección del problema que se presenta durante el 

proceso de verificación del espesor de flux, aplicado sobre los sustratos en el 

ensamble de procesadores, se explica con detalle en este capítulo, incluyendo los 

criterios de selección de cada uno de los módulos que componen la solución final y la 

descripción de la estructura y funcionamiento del hardware y software 

implementados. 

5.1 Análisis de soluciones y selección final. 

Para cumplir con los requerimientos establecidos se desarrolla un sistema que 

consiste en una unidad de control que se basa en un software de aplicación que 

administra el procedimiento de verificación en forma automatizada, desde una 

computadora. Este sistema se divide en tres módulos denominados Sistema de 

Comunicación, Sistema de Control de Posición y Sistema Identificación de Cupón. 

En la figura 5.1.1 se muestra en diagrama de bloques el sistema general a 

desarrollar. 

La unidad de información es una interfaz de usuario donde el operario del sistema 

puede ingresar y obtener información sobre el proceso. 

Para la selección del lenguaje de programación a utilizar en el desarrollo de la 

aplicación de la solución, se toma en cuenta la capacidad en la adquisición, control, 

análisis y presentación de datos, además que en el control de instrumentos exista la 

compatibilidad con el bus de comunicación del dispositivo medidor de espesor, el bus 

interfaz de propósito general (GPIB). 

LabVIEW es el lenguaje de programación seleccionado ya que cumple con todos los 

requerimientos anteriormente mencionados y además el código que utiliza es familiar 

en ingeniería. 
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Figura 5.1.1 Diagrama de bloques del Sistema General. 

Sistema de Comunicación 

Este sistema se basa en una interfaz de comunicación que permite interconectar el 

dispositivo medidor de espesor a la computadora y una aplicación que maneja el flujo 

de datos y comandos que se envían al instrumento. Procura almacenar los datos 

obtenidos en la computadora para evitar la alteración del valor de la medición. 

Como ya se ha mencionado el instrumento medidor en cuestión cuenta con el bus 

GPIB el cual fue diseñado específicamente para la comunicación de un ordenador 

con instrumentos electrónicos de medida. 
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La interfaz puede ser una tarjeta GPIB insertable en la computadora o algún tipo de 

controlador externo que utilice alguno de los puertos tradicionales (USB, serial 

paralelo, Ethernet, FireWire). 

En la siguiente tabla se enlistan las opciones analizadas para la selección de la 

interfaz utilizada en el desarrollo del proyecto. 

Tabla 5.1.1 Opciones de interfaz entre el dispositivo medidor y la computadora. 

Convertidor Cable 
Adicional 

Transferencia
(Kbytes/s) 

Precio 
($) 

Tarjeta 
insertable Cable GPIB 1500 850 

GPIB-USB No requiere 880 725 

GPIB-Ethernet Cable Ethernet 
Cable GPIB 900 1660 

GPIB-FireWire 
(IEEE1394) Cable GPIB 1500 1100 

GPIB-Puerto 
Paralelo 

Cable paralelo 
Cable GPIB - 1180 

GPIB-
RS232/485 

Cable serial 
Cable GPIB 38.4 1050 

El GPIB-USB (figura 5.1.2) fue el convertidor seleccionado (la hoja de datos se 

presenta al final en el anexo B.3.1) principalmente por utilizar una de las nuevas 

tecnologías de bus (USB siglas en ingles de Universal Serial Bus) el cual está 

implementado en cualquier computadora moderna. Además, este tipo de convertidor 

no requiere de dispositivos alternativos para realizar la conexión entre el dispositivo y 

la PC, es fácil de instalar y usar ya que el sistema lo reconoce automáticamente, y su 

precio es relativamente bajo. 

Por otra parte, en el sistema a instalar la distancia requerida del cable USB es 

máximo de 50 cm, el ambiente de trabajo donde se ubica no es muy ruidoso y 

gracias a que la computadora cuenta con seguro para las conexiones incluyendo 

para el puerto USB este no podrá ser fácilmente desconectado. Esto permite 

descartar las desventajas del puerto USB que se mencionan en el apartado 3.2.1 

Interfaces de comunicación. 
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Figura 5.1.2 Conector NI-GPIB-USB [4].  

Sistema de Control de Posición 

El objetivo de este sistema es garantizar que el centro del cupón sobre el cual se 

está realizando la medición se encuentre debajo del sensor del dispositivo medidor 

de espesor en el momento de la captura del dato. 

Inicialmente se propuso detectar por medio de sensores ambos lados del cupón 

colocado sobre la mesa corrediza del dispositivo medidor. Así cuando el operario 

coloca el cupón en la posición correcta los sensores generan una señal que indica 

que se puede capturar el dato del dispositivo medidor de espesor. Sin embargo se 

convertía en un sistema lento mientras el operario coloca el cupón en la posición 

requerida, y además no garantiza que se mantenga el cupón en posición en el 

momento que se está capturando la medición. 

Es por eso que surge la idea de fijar el cupón a la mesa corrediza del dispositivo 

medidor y sensar la posición de la mesa, la cual solo tiene movimiento en un sentido. 

Esto aligeraría un poco más el sistema ya que el operario solo debe colocar y fijar el 

cupón sobre la mesa corrediza y moverla hasta la posición determinada por el sensor 

que detecta la mesa. Pero a pesar de que aligera el sistema aún no se garantiza la 

precisión de la posición a la hora de la medición. 

Por lo tanto se decide agregar un sistema mecánico controlado que se encargue de 

llevar la mesa corrediza a la posición requerida. 

El cupón se debe fijar a la mesa corrediza de tal forma que el centro del cupón se 

pueda colocar justo debajo del sensor del dispositivo medidor y que el operario no 
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pueda manipular la posición del cupón en el momento de la captura del dato, además 

se debe tomar en cuenta que existen diferentes tamaños de cupones. La figura 5.1.3 

muestra el diseño seleccionado el cual consiste de placas metálicas con un boquete 

del tamaño del cupón. Estas placas son fácilmente removibles y se fijan a la mesa 

corrediza por medio de unos pines y agujeros. 

 
Figura 5.1.3 Diseño para fijar el cupón a la mesa corrediza del dispositivo medidor de 

espesor. 

Para el sistema mecánico se analizó la opción de fijar un motor de corriente continua 

(CC) o uno paso a paso a la mesa corrediza ya sea por medio de un tornillo sin fin o 

por medio de fajas y poleas. 

Para la selección del motor se analizó principalmente el grado de exactitud de 

posicionamiento debido a la necesidad de situar el cupón en un lugar muy específico 

que permita realizar la medición de espesor exactamente en el centro del cupón; la 

capacidad de regulación de velocidad para que este sea un sistema rápido pero que 

conforme se va acercando a la posición requerida la velocidad vaya disminuyendo 

para lograr una mayor estabilidad o evitar sobreimpulsos; la facilidad de inversión del 
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sentido de giro debido a que la mesa corrediza debe estar constantemente entrando 

y saliendo. 

En cuanto al grado de exactitud de posicionamiento el tipo de motor paso a paso 

tiene la desventaja que depende del tamaño del paso, ya que puede que el último 

paso para lograr la posición deseada la sobrepase y que un paso anterior no la 

alcance, y aunque es posible disminuir el tamaño del paso para ello es necesario 

aumentar el número de bobinas del estator lo que aumenta el costo y disminuye 

considerablemente el rendimiento del motor. 

Por su lado el motor de corriente continua comprende todas las posiciones ya que va 

avanzando linealmente y por medio de un control de velocidad se puede alcanzar la 

posición deseada simplemente des-energizando el motor. En la figura 5.1.4 se ilustra 

esta ventaja del motor de corriente continua con respecto a un motor paso a paso. 

 
Figura 5.1.4 Comparación del grado de exactitud de posicionamiento entre el motor de 

corriente continua y el de paso a paso. 

Tanto el motor paso a paso como el de corriente continua son útiles cuando es 

necesario regular la velocidad. Sin embargo el de corriente continua se simplifica por 

el hecho de que la velocidad desarrollada es proporcional al voltaje aplicado es decir 

que para controlar la velocidad simplemente se debe de controlar la tensión aplicada 

y a mayor tensión, mayor corriente y mayor par del motor. Por otro lado el motor 

paso a paso depende de la frecuencia de excitación de sus bobinas, y cuando 

aumenta la velocidad de giro se produce un aumento de la fuerza electromagnética 

generada y por consecuencia una disminución de la corriente absorbida por los 

bobinados del estator lo que disminuye el par motor. 
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En cuanto al cambio del sentido de giro para un motor de corriente continua consiste 

simplemente en invertir la polaridad de la tensión aplicada a sus bornes y para un 

paso a paso se debe aplicar una secuencia inversa a la secuencia de excitación. 

Para el proyecto se utiliza un motor de corriente continua con el cual cuenta la 

empresa. La información sobre este se encuentra en el anexo B.3.2. 

Para acoplar el motor a la mesa corrediza se utiliza el juego de poleas y faja tal como 

lo muestra la figura 5.1.5, principalmente debido a que una faja puede ceder hasta 

reventarse ante un desajuste o problema con la planta, en cambio un tornillo sin fin 

además puede dañar otras partes de la planta como el motor o los acoples. 

Para sensar la posición de la mesa corrediza y en consecuencia del cupón metálico, 

después de analizar desde sistemas de visión, sensores ópticos, láser, inductivos, 

capacitivos, fibra óptica, entre otros se concluyó utilizar un potenciómetro acoplado al 

eje del motor (ver figura 5.1.5), principalmente por la facilidad de implementación ya 

que consiste simplemente en alimentar con un voltaje las terminales fijas y en la 

terminal móvil se producirá un voltaje proporcional a la posición; y además por su 

bajo costo. 

Para garantizar que el incremento o decremento de voltaje dado por la terminal 

variable del potenciómetro sea proporcional a la variación de la posición de la mesa 

corrediza, el potenciómetro debe tener un comportamiento lineal. Además debido a 

que el motor da varios giros para completar la carrera de la mesa corrediza, el 

potenciómetro debe ser de rotación continua. 
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Figura 5.1.5 Sistema mecánico para mover automáticamente la mesa corrediza. 

El potenciómetro seleccionado se observa en la figura 5.1.6. Este es de rotación 

continua, lineal y de 100kΩ de resistencia, en el anexo B.3.4 se encuentra la hoja de 

datos respectiva. 

 
Figura 5.1.6 Potenciómetro de precisión utilizado como sensor de posición [7]. 
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Como el control del sistema se pretende hacer por medio del programa en LabVIEW 

desde la computadora, es necesario un convertidor analógico-digital que permita 

llevar la señal del sensor de posición (potenciómetro) a la computadora y a la vez un 

convertidor digital-analógico que permita enviar la señal de control hacia el motor 

desde la computadora. El dispositivo que se muestra en la figura 5.1.7 fue el 

adoptado, este es una tarjeta de adquisición de datos que cuenta con al menos una 

salida analógica y una entrada analógica. Este dispositivo es muy fácil de instalar ya 

que es externo, es decir, no es necesario insertarlo dentro de la computadora sino 

que se conecta por medio del puerto USB. Además, es compatible con el lenguaje de 

programación a utilizar (LabVIEW) lo que facilita su programación. Las 

especificaciones de esta tarjeta USB-6608 se encuentran en el anexo B.3.5. 

 
Figura 5.1.7 Tarjeta de adquisición de datos [8]. 

Sistema Identificación del Cupón 

Este sistema pretende que se realice la lectura de espesor sobre los cuatro cupones 

y además que durante el cálculo de espeso de flux (la resta de la lectura antes a la 

lectura después de aplicar el flux) los datos correspondan al mismo cupón. 

La propuesta inicial consistía en agujerear los cupones cada uno con una 

configuración diferente y por medio de sensores de fibra óptica (transmisor-receptor) 

detectar la existencia o no del agujero (ver figura 5.1.8) determinándose el cupón en 

medición. 
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Figura 5.1.8 Identificación del cupón metálico por medio de sensores ópticos. 

Este método necesitaría de cuatro parejas de sensores (transmisor-receptor) un 

amplificador de la señal para cada pareja y una tarjeta de adquisición con cuatro 

entradas digitales. Esta técnica se complica en cuanto al montaje de los sensores por 

la alta precisión que deben tener para la recepción del rayo, y al hecho de agujerear 

los cupones. 

Otra posibilidad fue utilizar una cámara que capture la imagen del cupón al cual se le 

realizaría una marca como un número, y desde una aplicación en la computadora 

poder descifrar la imagen y determinar el cupón en medición. Además de la cámara 

se necesitaría una tarjeta de adquisición de imágenes para insertar en la 

computadora y desarrollar un algoritmo para la interpretación de la imagen 

capturada. 

Finalmente se emplea un sistema de código de barras, que consiste en marcar con 

un código de barras cada cupón metálico con la información respectiva como el 

tamaño y el número que lo identifica; y de un lector de código de barras que 

decodifique la información, la procese y la envíe a la computadora. La aplicación en 

LabVIEW captura la información y designa el campo correspondiente para almacenar 

el valor de la medición de espesor de flux. 

Para el marcaje de los cupones se utilizará el código de barras de dos dimensiones 

matriz de puntos (figura 5.1.9), principalmente a que este se puede imprimir 

directamente sobre metal por medio de láser, caso contrario a los códigos 
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unidimensionales que requieren fondo blanco por lo que sería necesario imprimir el 

código sobre una etiqueta blanca que se colocaría sobre el cupón. El problema de la 

etiqueta que requieren los códigos unidimensionales es que el grosor de esta puede 

afectar la impresión de flux y además puede ser removible fácilmente. 

 
Figura 5.1.9 Código de matriz de puntos con la información Cupón 1. 

La desventaja del sistema de código de barras de dos dimensiones es el alto 

precio del lector y del marcaje, sin embargo la empresa cuenta con la herramienta 

para imprimir el código por medio de láser y con el lector el cual se observa en la 

figura 5.1.10. 

 
Figura 5.1.10 Cámara lectora de códigos de matriz HE1515 y sus principales conexiones [9]. 

El lector de la figura 5.1.10 decodifica códigos de barras tanto unidimensionales 

como de dos dimensiones, posee comunicación Ethernet y serial (RS232). Las 

demás especificaciones se pueden leer en el anexo B.3.6. 
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5.2 Descripción del hardware 

Sistema de Comunicación 

El hardware utilizado para el desarrollo del sistema de comunicación se ilustra en la 

figura 5.2.1, este consta de una computadora con puerto USB, el dispositivo medidor 

de espesor modelo CL-250 de la marca Ono-Sokki y la interfaz de comunicación el 

convertidor GPIB-USB. 

 
Figura 5.2.1 Hardware empleado en el Sistema de Comunicación. 

Sistema de Control de Posición 

Para la construcción de este sistema se utiliza la misma computadora que para el 

Sistema de Comunicación, por tanto esta debe poseer al menos dos puertos USB 

para también conectar la tarjeta de adquisición de datos (USB-6008). Fue necesario 

construir un circuito acondicionador de señales, una etapa de potencia y una fuente 

de alimentación de ±9 voltios para alimentar el motor que mueve la nueva mesa 

corrediza por medio de poleas y faja. El material mencionado anteriormente más el 

potenciómetro que se utiliza como sensor de posición corresponde al hardware 

empleado para este sistema de control, el cual se ilustra en la figura 5.2.2. Los 

destalles de diseño e implementación se describen más adelante. 
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Figura 5.2.2 Hardware empleado en el Sistema de Control de Posición. 

Este sistema consiste en un control automático en lazo cerrado ya que 

continuamente se está verificando la señal de posición dada por el potenciómetro 

para compararla con la señal de referencia establecida desde la computadora, y 

calcular la señal de error (diferencia entre la señal de referencia y la de posición), la 

cual es utilizada en el controlador para generar la señal de control que mueve el 

motor. En la figura 5.2.3 se muestra en diagrama de bloques el sistema de control en 

lazo cerrado. 
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Figura 5.2.3 Diagrama de bloques de un control en lazo cerrado. 

A continuación se va a explicar cada una de las señales del diagrama de bloques de 

la figura 5.2.3: 

La señal r corresponde a la señal de referencia que indica la posición deseada. Es 

generada dentro de la computadora y corresponde al voltaje que debe alcanzar la 

terminal variable del potenciómetro para lograr ubicar la mesa corrediza en la 

posición requerida. 

La señal y corresponde al voltaje generado en la patilla variable del potenciómetro la 

cual es proporcional a la posición actual de la mesa corrediza. Es enviada a la 

computadora por medio de una de las entradas analógicas de la tarjeta de 

adquisición de datos. 

La señal e corresponde a la diferencia entre la señal r y la señal y, conocida como la 

señal de error. Se calcula dentro de la computadora, y es la entrada del controlador 

que permite determinar la amplitud y dirección del voltaje de alimentación del motor 

que mueve la mesa corrediza con el objetivo de disminuir y anular esta diferencia. 

La señal u corresponde al voltaje producido por el controlador que opera la velocidad 

y sentido del motor con el objetivo de disminuir y anular la señal de error (e). Esta 

señal se inicia en la computadora se extrae por medio de una salida analógica de la 

tarjeta de adquisición, se pasa por el acondicionador de señales y la etapa de 

potencia, para finalizar en las terminales del motor. 
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Para el desarrollo de este sistema fue necesario modificar la mesa corrediza del 

dispositivo medidor, para lograr fijar el cupón a la mesa independientemente del 

tamaño y además para acoplar todo el mecanismo del motor y potenciómetro. En la 

figura 5.2.4 se pueden apreciar los cambios realizados. 

 
Figura 5.2.4 Cambios realizados a la mesa corrediza del dispositivo medidor de espesor. 

El potenciómetro utilizado como sensor de posición es de rotación continua y posee 

una resistencia máxima de 100 kΩ. El eje de este se encuentra acoplado a una polea 

del sistema mecánico movido por el motor, por tanto varía su resistencia en razón al 

movimiento del motor. Entre las patillas externas (terminales fijas) se aplica un voltaje 

de 5 voltios de corriente directa que se obtiene de una fuente externa suministrada 

por la tarjeta de adquisición de datos entre las terminales 31 y 32. El voltaje de la 

terminal variable del potenciómetro corresponde a la posición actual de la mesa 

corrediza. Esta se conecta a la entrada analógica AI0 de la tarjeta la cual permite un 

rango de voltaje de ±10 voltios. La figura 5.2.5 ilustra la conexión del potenciómetro. 

 
Figura 5.2.5 Conexión del sensor de posición (potenciómetro). 
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La gráfica que se presenta en la figura 5.2.6 muestra el comportamiento del voltaje 

que se obtiene de la terminal variable del potenciómetro respecto a las vueltas del 

eje del mismo. El potenciómetro continuo de menos vueltas encontrado es el de 14 

vueltas y debido a que la carrera de la mesa corrediza es de 75 mm (vuelta y media), 

el potenciómetro varía aproximadamente 10% de su capacidad. En la figura 5.2.6 se 

marca en rojo el rango de variación del voltaje proporcionado por el potenciómetro 

(0,36 a 0,76 voltios).  

 
Figura 5.2.6 Curva característica del potenciómetro utilizado. 

La tarjeta de adquisición de datos se conecta directamente al puerto USB de la 

computadora por medio de un cable propio de la tarjeta. Como ya se ha mencionado 

anteriormente esta se encarga de enviar la señal de posición hacia la computadora 

por medio de una entrada analógica de 12 bits de resolución con una tasa de 

muestreo de 10000 muestras por segundo; y de llevar la señal de control hasta el 

motor por medio de una de las salidas analógicas de 12 bit de 150 Hz. El rango de 

voltaje que proporciona la salida analógica es de 0 a +5 voltios con una corriente 

máxima de 5 miliamperios. 

El voltaje nominal del motor utilizado para mover la mesa es de 9 voltios y debido a 

que es necesario estar cambiando el sentido de giro del mismo, se requiere que la 

señal de control varíe entre -9 y +9 voltios, por lo tanto se debe desarrollar un circuito 

acondicionador de señales que ajuste la señal de 0 a +5 voltios que proporciona la 

tarjeta de adquisición en una señal que varié de -9 a +9 voltios. Sin embargo esta 
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señal no tendrá la potencia necesaria para mover el motor por lo que además se 

debe implementar una etapa de potencia. 

El diseño de los circuitos mencionados más la fuente de alimentación se explica a 

continuación. 

Circuito Acondicionador de Señales [10]: 

Este circuito se construye con amplificadores operacionales y resistencias eléctricas, 

por su bajo costo y facilidad para conseguir en el mercado. Se comporta acorde con 

la ecuación de una línea recta (5.2.1)  

bmxy +=             (5.2.1) 

En la figura 5.2.7 se observa la gráfica del voltaje de entrada (Ve) entre el voltaje de 

salida del acondicionador de señales. El voltaje de entrada corresponde al entregado 

por la tarjeta de adquisición de datos mientras que el de salida es el que se requiere 

para el control del motor. 

 
Figura 5.2.7 Características entra/salida de circuito acondicionador de señales. 
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Para la gráfica de la figura anterior se obtiene la pendiente que se observa en la 

ecuación (5.2.2) y se observa que la intersección con el eje Vs corresponde a -9V. 

( ) 6,3
5,25
)09(
=

−
−

=m            (5.2.2) 

Por lo tanto, la ecuación del voltaje de salida de circuito acondicionador de señales 

es: 

96,3 −= es VV             (5.2.3) 

El circuito de la figura 5.2.8 se trata de un sumador inversor con un amplificador 

operacional. El voltaje de salida se representa en la ecuación (5.2.4). 

 
Figura 5.2.8 Circuito Sumador Inversor. 

2
2

1
1

V
R
R

V
R
R

V ff
o −−=            (5.2.4) 

Para conseguir que (5.2.4) coincida con (5.2.3) se debe invertir la señal de entrada 

V1, esto se logra utilizando un amplificador inversor de ganancia unitaria como el de 

la figura 5.2.9 para finalmente obtener la ecuación (5.2.5). 

 
Figura 5.2.9 Amplificador inversor de ganancia igual a 1. 
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De acuerdo a la correspondencia de (5.2.3) con (5.2.5) se obtiene: 
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Se utiliza la fuente de +9V como V2 por lo tanto: 

1
2

=
R
R f  

Si se elige Rf =R2=47 kΩ se obtiene que R1=13.055 kΩ. 

El circuito acondicionador de señales diseñado se muestra en la figura 5.2.10. 

 
Figura 5.2.10 Circuito Acondicionador de Señales 

Circuito de potencia 

La etapa de potencia se implementa con dos transistores de potencia uno PNP 

(A940) y otro NPN (D1138) conectados tal como lo muestra la figura 5.2.11. Las 

hojas de datos respectivas se encuentran en el anexo B.3.7 y B.3.8. 
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Figura 5.2.11 Etapa de potencia. 

El circuito final se muestra en la figura 5.2.12 

 
Figura 5.2.12 Circuito Acondicionador de señales con Etapa de Potencia. 

Fuente de Alimentación 

Para la alimentación de los circuitos mencionados anteriormente se necesita de una 

fuente de ±9 voltios es decir una fuente simétrica, para ello se necesita de un 

transformador con derivación central, un rectificador de onda completa, un regulador 

de 9V y otro de -9V. En la figura 5.2.13 su observa el diseño de la fuente utilizada. 

 
Figura 5.2.13 Fuente simétrica de ±9 voltios. 

Los bloques que conforman la señal que controla el motor se muestran en la figura 

5.2.14. 
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Figura 5.2.14 Diagrama de bloques de la señal de control. 

El motor utilizado tiene acoplado un engranaje con una reducción de 32:1 es decir 

que para obtener una vuelta al final del engranaje el motor debe realizar 32 vueltas, 

además de reducir la velocidad del motor, el engranaje le da mayor fuerza. La hoja 

de datos de este dispositivo se obtiene del B.3.3. La figura 5.2.15 ilustra la forma 

como se adapta el motor a la mesa corrediza por medio de poleas y faja. 

 
Figura 5.2.15 Adaptación del motor a la mesa corrediza 
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Sistema Identificación del Cupón 

El hardware de este sistema se muestra en la figura 5.2.16. Los cupones se marcan 

con una matriz de datos para diferenciarlos, mientras que el lector de código de 

matriz se fija de tal forma que pueda leer el código impreso sobre el cupón. Para 

enviar la información a la computadora se conecta el lector a la computadora a través 

del puerto serie RS-232. 

 
Figura 5.2.16 Hardware empleado en el Sistema Identificación del Cupón. 
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5.3 Descripción del software 

El control del sistema desarrollado para realizar la verificación de espesor de flux en 

forma automática y confiable, consiste en un programa de computadora diseñado 

con el lenguaje de programación LabVIEW. 

El programa básicamente se encarga de guiar al operario durante el proceso de 

verificación mediante una interfaz gráfica, de establecer la señal de control para 

posicionar el cupón, de obtener los datos de la medición y calcular el espesor de flux, 

además de almacenar y presentar la información necesaria con respecto a la 

medición. 

A través de la interfaz gráfica el usuario debe ingresar la información del proceso 

antes de iniciar con la medición. Esta información se refiere a los datos del operario 

como número de identificación, nombre y el número del turno de horario de trabajo, a 

la fecha y hora, a la línea de producción sobre la cual se está trabajando, al producto 

en proceso y al motivo de la verificación. 

La fecha y la hora además del número de semana y turno actual de trabajo son datos 

que el programa genera. El resto de información se encuentra en bases de datos 

(archivos Excel) por lo que el usuario simplemente selecciona de listas obtenidas de 

estas bases que se encuentran vinculadas al campo respectivo. La figura 5.3.1 

muestra el aspecto de la parte de la interfaz para ingresar la información. 

 
Figura 5.3.1 Interfaz gráfica de la aplicación para ingresar la información del proceso. 
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Las bases de datos pueden modificarse (borrar o ingresar datos) dentro de la 

aplicación solamente por personal autorizado ya que esta opción se encuentra 

protegida con contraseña. El objetivo de las bases de datos es aligerar el proceso y 

asegurar que se ingrese información correcta. 

El producto tiene asignados los límites que definen el rango dentro del cual se debe 

encontrar el valor del espesor de flux para que su funcionamiento sea adecuado. Así, 

en el momento que el operario selecciona el producto, estos límites se obtine en 

forma automática y son utilizados para comprobar si la verificación pasó o falló. 

Ya una vez que el operario ingresa la información del proceso puede iniciar con la 

toma de datos de espesor. En la figura 5.3.2 se observa la pantalla de la interfaz 

gráfica de la medición. 

 
Figura 5.3.2 Interfaz gráfica de la aplicación para realizar la medición de espesor. 

En esta interfaz hay un campo que muestra la lectura realizada por el dispositivo 

medidor de espesor. Para obtener esta lectura y también programar la referencia del 

dispositivo, desde la aplicación desarrollada se maneja el flujo de datos y comandos 

que se envían al instrumento para que este responda a las peticiones realizadas. 
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La aplicación lee del dispositivo en el momento que el cupón se encuentra en 

posición de medición, y únicamente cuando se trata de la primera medición sin flux 

es que se realiza la programación de la referencia. En el diagrama de flujo de la 

figura 5.3.3 se observa cada serie de comandos enviados al dispositivo para lograr la 

captura de datos y la programación de la referencia. 

Inicio de la 
Mecición

Comandos Enviados:

CSP:     (Command of StoP) Detiene la medición.
LDS 1,0,0]:  (Lcd Display Set) Despliega en la primera línea de la 

    pantalla, el espesor, de la diferencia entre el valor 
    medido y la referencia puesta.

LDR 1:         (Lcd Display Read) Envía por el puerto GPIB el dato 
    desplegado en la primera línea de la pantalla.

CST:     (Command of STart) Empieza la medición.

¿Primer 
Cupón?

Comandos Enviados:

CPS: (Command of PauSe) Pausa la medición.
DIS 0,1: (Display Set) Despliega el espesor del el valor neto leído 

en la pantalla de leds.
RAS: (Ref. Auto Set) Pone el valor leído como referencia igual a 

cero
DIS 0,0:  (Display Set) Despliega el espesor de la diferencia entre el 

valor medido y la referencia puesta.
CST:     (Command of STart) Empieza la medición.

¿Último 
Cupón?

¿Referencia 
Ajustada?

Sí
No

Fin

Sí

No

No

 
Figura 5.3.3 Flujo de comandos enviados al dispositivo medidor. 

En el momento que se detecta que el cupón se encuentra en la posición correcta 

para la medición, se almacena el dato en el campo respectivo dependiendo al 

número de cupón y momento (antes o después de imprimir el flux). 
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Una vez que se han capturado todos los datos el programa calcula el espesor de flux 

para cada cupón, el promedio y la desviación estándar, además muestra en una 

gráfica el historial de los datos almacenados para la línea de producción y el producto 

seleccionados. El diagrama de flujo de la figura 5.3.4 y 5.3.5 explica el procedimiento 

seguido durante la medición de espesor. 

Inicio

Mensaje 1

¿Información 
Completa?

No

Obtener lectura del 
dispositivo medidor

Sí

Mensaje 2

¿Enter 
Presionado?

No

Mensaje 3

Sí

¿Enter 
Presionado?

Llevar mesa corrediza 
a posición 1

¿En posición 1?

No

Sí

No

Leer código de la 
placa removible

Sí

Corresponde 
placa-producto

Mensaje 4a Mensaje 4b

No Sí

¿Enter 
Presionado?

No

A

A

Sí
¿Enter 

Presionado?

No

B

Mensaje 1: Introduzca la 
información del proceso 
completando los campos 

respectivos.
Se envía el flujo de 

comando para leer del 
dispositivo medidor.

Mensaje2: Limpie los 
cupones a medir, 
sensores, placa 

removible, mesa corrediza 
y presione Enter.

Mensaje3: Coloque la 
placa removible 

correspondiente al 
producto seleccionado y 

presione Enter

Se genera y activa la 
señal de control que 

mueve el motor

Se refiere al código de 
matriz de punto con la 
información de la placa

Mensaje4b: 
Coloque el 
cupón en el 
boquete de la 
placa removible 
y presione Enter

Mensaje4a: Placa 
incorrecta, coloque la 

placa correcta y presione 
Enter

 
Figura 5.3.4 Primera parte del diagrama de flujo del algoritmo del programa desarrollado 

para el proceso de verificación de flux. 
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B

Llevar mesa corrediza a 
la posición de medición 

¿En posición de 
medición?

No

¿Primera 
medición?

Sí

Leer código del cupón 
en medición

Programar referencia 
al dispositivo

¿Referencia 
Ajustada?

No

SíNo
C

C

Sí
Almacenar lectura en 

campo correspondiente

Llevar mesa corrediza 
a posición 1

¿En posición 1?

No

¿Cuarta medición?

Sí

¿Octava medición?

No

A

No
Mensaje 5

Sí

Mensaje 6

¿Enter 
Presionado?

No

¿Contraseña 
Correcta?

Sí

No

A

Calcular y mostrar 
resultados de la 

medición

Sí

Fin

Mensaje5: 
Imprima el flux

Mensaje6: Introduzca 
contraseña para 

continuar con el proceso 
y presione Enter

Se genera y activa la 
señal de control que 

mueve el motor

Se envía el flujo 
de comando 

correspondientes 
al dispositivo

Se calcula el espesor de flux 
por medio de las mediciones 

antes y después, el 
promedio la desviación 
estándar y se grafica el 

historial de las mediciones 
para la línea y producto 

seleccionados.  
Figura 5.3.5 Segunda parte del diagrama de flujo del algoritmo del programa desarrollado 

para el proceso de verificación de flux. 
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Diseño del Controlador 

Para el diseño del controlador se parte de las especificaciones en el dominio del 

tiempo del sistema en lazo cerrado, por lo que se crea un algoritmo en LabVIEW 

para capturar el comportamiento de la salida del sistema ante una entrada escalón 

de amplitud igual a 1.016785 V, la figura 5.3.6 muestra este comportamiento. 

Para simplificar el análisis del sistema, este se considera como un sistema prototipo 

de segundo orden (refiérase al apartado 3.2.3). 

 
Figura 5.3.6 Comportamiento real del sistema de control en lazo cerrado ante una entrada 

escalón de 1.016785 V. 

Las especificaciones en el dominio del tiempo para el comportamiento del sistema en 

lazo cerrado son las siguientes. 

Sobrepaso máximo: Vm p 313445.0016785.1330230.1 =−=  

Tiempo de estabilización: ts = 1.175 s 

Tiempo de pico: tp=0.300 s 

Sustituyendo los valores en la ecuación (3.2.6) se obtiene el factor de 

amortiguamiento relativo del sistema. 

 ( )
( )

346416.0
)313445.0ln(

)313445.0ln(
22

2

=
+

=
π

ξ         (5.3.1) 

Y de la ecuación (3.2.7) se calcula la frecuencia natural. 
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( )

163189.11
346416.01300.0 2

=
−

=
π

nw         (5.3.2) 

Suponiendo que se trata de un sistema prototipo de segundo orden la función de 

transferencia en lazo abierto del sistema dada por (3.2.1) es: 

 
ss

sG p 734215.7
616789.124)( 2 +

=           (5.3.3) 

Y la respectiva función en lazo cerrado de con respecto a la ecuación (3.2.2) es: 

 
616789.124734215.7

616789.124)( 2 ++
=

ss
sG         (5.3.4) 

Para el diseño del controlador se especifica que este no presente un sobrepaso 

máximo de 5%, y que el tiempo de estabilización sea menor a 0.8 s. Por lo que se 

diseña un controlador proporcional derivativo (PD) de la forma que presenta la 

ecuación (5.3.5) 

 ⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
+
+

=
0

0

ps
zs

KK PD           (5.3.5) 

Un sobrepaso menor al 5% significa que el factor de amortiguamiento debe ser 

menor a 0.690107 tal como lo muestra la ecuación (5.3.6) que resulta de la ecuación 

(3.2.6). 

 ( )
( )

690107.0
)05.0ln(

)05.0ln(
22

2

=
+

=
π

ξ          (5.3.6) 

Se elige un punto sx en el plano complejo de s que se encuentre en el área donde se 

cumpla las especificaciones definidas. Para ello se calcula el ángulo θ  y el factor 

nwξ , los resultados se muestran en (5.3.7) y (5.3.8). 

     (5.3.7) °=== −− 361420.46)690107.0(cos)(cos 11 ζθ

 5
8.0

44
===

s
n t

wξ           (5.3.8) 
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En la figura 5.3.7 se subraya el área en plano complejo de s donde se debe 

encontrar el punto sx. El punto seleccionado es: 

 57 jsx ±−=           (5.3.9) 

 

 
Figura 5.3.7 Área en el plano complejo de s donde se cumple con las especificaciones 

definidas sobre el diseño del controlador. 

Las ecuaciones para el cálculo del polo y el cero del compensador PD se presentan 

a continuación. 

 
⎟
⎠
⎞

⎜
⎝
⎛ +

⎟
⎠
⎞

⎜
⎝
⎛ −

−=

2
cos

2
cos

*0 φθ

φθ

xsz         (5.3.10) 

 
⎟
⎠
⎞

⎜
⎝
⎛ −

⎟
⎠
⎞

⎜
⎝
⎛ +

−=

2
cos

2
cos

*0 φθ

φθ

xsp         (5.3.11) 

Donde. 

 °=⎟
⎠
⎞

⎜
⎝
⎛= − 537678.35

7
5tan 1θ         (5.3.12) 

 º108541.46)(º180 =−∠= xp SGφ        (5.3.13) 
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Sustituyendo estos valores en (5.3.10) y (5.3.11) se obtiene: 

319405.11

2
108541.46537678.35cos

2
108541.46537678.35cos

*570 −=
⎟
⎠
⎞

⎜
⎝
⎛ +

⎟
⎠
⎞

⎜
⎝
⎛ −

+−−= jz

       (5.3.14) 

537446.6

2
108541.46537678.35cos

2
108541.46537678.35cos

*570 −=
⎟
⎠
⎞

⎜
⎝
⎛ −

⎟
⎠
⎞

⎜
⎝
⎛ +

+−−= jp

       (5.3.15) 

El cálculo del k del compensador se realiza a través de la ecuación (5.3.16). 

 459039.0
*)(

1

0

0
=

−
−

=

ps
zs

sG
k

x

x
xp

       (5.3.16) 

Al final el resultado del compensador se muestra en la ecuación (5.3.17). 

 
319405.11
537446.6459039.0

+
+

=
s
skPD         (5.3.17) 

Y la función de transferencia del sistema compensado en lazo abierto se presenta a 

continuación. 

sss
sG

s
s

ss
G

p

p

546712.8705362.19
967839.373203966.57

319405.11
537446.6459039.0*

734215.7
616789.124

23

2

++
+

=

+
+

+
=

         (5.3.18) 

El controlador diseñado es implementado al sistema en forma digital por medio de 

herramientas propias de LabVIEW. 
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Capítulo 6  Resultados y Análisis 

En este capítulo se presentan y discuten los resultados obtenidos del proyecto. Este 

hace énfasis en el diseño del control del sistema que mueve la mesa, en la 

implementación del hardware y en los datos sobre medidas de espesor. 

6.1 Comportamiento del sistema de control 

Los cálculos del controlador del sistema de control de posición se presentan en la 

sección Diseño del Controlador en el apartado 5.3 Descripción del software. La 

función de transferencia en lazo cerrado (5.3.4) se calcula por medio de las 

especificaciones en el tiempo de la respuesta ante un escalón (ver figura 5.3.6), 

considerando al sistema de segundo orden. 

Por medio de la herramienta computacional Matlab se graficó el comportamiento 

teórico de la función de transferencia obtenida en lazo cerrado ante un escalón de 

amplitud 1.016785 V superpuesta con el comportamiento real del sistema de la figura 

5.3.6 (ver figura 6.1.1). 

 

Real

Teórico 

Figura 6.1.1 Respuesta ante un escalón de amplitud 1.016785 de la función de transferencia 
de la ecuación (5.3.4). 
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En la figuras 6.1.1 se observa que tanto el comportamiento real del sistema en lazo 

cerrado como la simulación de la función de transferencia calculada son similares en 

cuanto a forma (bajo amortiguamiento), tiempo pico (0.3 s), sobrepaso máximo (30%), 

y tiempo de estabilización (1.35 s) lo que permite concluir que la función de 

transferencia del sistema en lazo cerrado se aproxima a la ecuación (5.3.4) de un 

sistema prototipo de segundo orden. Las principales diferencias de las gráficas de la 

figura 6.1.1 se deben a que el comportamiento real se graficó a 10 muestras por 

segundo. 

Para disminuir el sobrepaso que presenta el sistema a un máximo de 5% e 

igualmente lograr un tiempo de estabilización menor a 0.8 s se diseñó un controlador 

proporcional derivativo (refiérase a la ecuación 5.3.17). Al final la función de 

transferencia en lazo abierto con el controlador se presenta en la ecuación (5.3.18). 

El controlador calculado se integró al sistema a través de un algoritmo propio de 

LabVIEW, en la figura 6.1.2 se puede observar la respuesta al escalón de amplitud 

1.016785 V del sistema real compensado. 

 
Figura 6.1.2 Respuesta al escalón del sistema de control de posición con controlador PD. 

De la gráfica de la figura 6.1.2 se obtiene que el sistema presenta un sobrepaso 

máximo de 7.518797% (ecuación 6.1.1) y un tiempo de estabilización de 1 s. 

 
%518797.7100*

016785.1
016785.1093235.1% =

−
=pm

 (6.1.1) 
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En la tabla 6.1.1 se comparan las especificaciones requeridas durante el desarrollo 

del controlador y las obtenidas del comportamiento real del sistema controlado. 

Tabla 6.1.1 Especificaciones en el dominio del tiempo. 
 Requerido Obtenido Diferencia 

Sobre paso máximo 
(%) 5 7.518797 2.5 

Tiempo de 
estabilización (s) 0.8 1s 0.2 

De la tabla 6.1.1 se deduce que las especificaciones requeridas no se alcanzaron sin 

embargo la diferencia que presentan con las obtenidas no afecta al sistema ya que 

un 2.5% más en el sobrepaso máximo significa 0.025420 V lo cual equivale a 

aproximadamente 0.8 mm de la carrera de la mesa corrediza lo cual es rápidamente 

compensado. 

Las diferencias que se presentan en la tabla 6.1.1 se justifica principalmente en que 

para el cálculo teórico del compensador PD se supuso un sistema prototipo de 

segundo orden para aproximar la función de transferencia, lo cual no se puede 

considerar como exacto. 

 71



6.2 Implementación del Hardware 

En la imagen de la figura 6.1.3 se muestra la parte del hardware implementado, 

donde se puede observar la computadora de escritorio, el dispositivo medidor de 

espesor, la mesa corrediza modificada y una bandeja transportadora con cupones 

metálicos y sustratos. 

 
Figura 6.2.1 Foto del Sistema completo para le monitoreo de espesor de flux de forma más 

automatizada. 

El dispositivo medidor se conectó a la computadora (ver figura 6.2.2) para almacenar 

los valores de espesor por medio del convertidor GPIB-USB, lo cual era un objetivo 

de hardware del proyecto. A través de esta conexión se consigue controlar el 

dispositivo medidor desde la computadora para programar la referencia y enviar la 

lectura de espesor realizada hacia la computadora para mostrarla en tiempo real por 

medio de una interfaz gráfica. Además, esto conexión evita la manipulación de los 

controles del dispositivo lo que le permite aumentar su ciclo de vida 
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Figura 6.2.2 Conexión del dispositivo medidor de espesor con la computadora a través del 

cable GPIB-USB. 

Las modificaciones realizadas a la mesa corrediza para lograr colocar el centro del 

cupón bajo los sensores del dispositivo medidor se muestran en la figura 6.2.3. Una 

debilidad de esta adaptación es la parte de la faja, ya que se acondicionó una faja 

dentada que presenta los dientes muy separados (5 mm) entre si, y debido al tamaño 

de las poleas (14 mm de diámetro) esta tiende a desencajar produciendo un 

trabamiento, sin embargo este es compensado por el controlador logrando alcanzar 

la posición deseada. 

En la figura 6.2.3 se puede observar la adaptación del motor y potenciómetro (como 

sensor de posición) a la mesa corrediza por medio de una faja dentada, las placas 

removibles para la colocación del cupón en una poción fija, una caja en acrílico 

donde se encuentra la fuente de alimentación el circuito acondicionador de señales 

con etapa de potencia y la tarjeta de adquisición de datos. En la imagen inferior 
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izquierda se ve cuando el centro del cupón se encuentra bajo el sensor del 

dispositivo medidor. 

 

Motor
Mesa Corrediza

Circuitos 
Faja

Sensor

Cupón  
Metálico

Placas Removibles

Figura 6.2.3 Modificaciones realizadas a la mesa corrediza. 

El funcionamiento de la fuente de alimentación, el acondicionador de señales y la 

etapa de potencia se analiza a través de los datos de la tabla 6.2.1. Esta tabla 

presenta las mediciones de voltaje en los puntos correspondientes a la entrada del 

acondicionador de señales y a la salida de la etapa de potencia, para diferentes 

voltajes programados en la tarjeta de adquisición de datos desde la computadora. 

Para el cálculo teórico del voltaje de salida de la etapa de potencia se utiliza la 

ecuación (5.2.3) y las mediciones prácticas fueron realizadas por medio de un 

voltímetro. Además se calcula la diferencia entre el valor teórico y el experimental 

para concluir el desempeño. 
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Tabla 6.2.1 Comportamiento del Circuito Acondicionador de Señales (CAS) con etapa de 
potencia y la fuente da alimentación. 

Voltaje a la salida de la  
etapa de potencia (V) 

Voltaje 
Programado  

(V) 

Voltaje a la 
entrada CAS 

(V) Teórico Experimental Diferencia 
0.0 0.001 -8.996 -8.980 -0.016 
0.5 0.496 -7.214 -7.240 0.026 
1.0 0.994 -5.422 -5.490 0.068 
1.5 1.494 -3.622 -3.726 0.104 
2.0 1.990 -1.836 -1.975 0.139 
2.5 2.489 -0.040 -0.219 0.179 
3.0 2.992 1.771 1.552 0.219 
3.5 3.486 3.550 3.300 0.250 
4.0 3.987 5.353 5.070 0.283 
4.5 4.490 7.164 6.820 0.344 
5.0 4.980 8.928 8.580 0.348 

De la tabla se observa que la diferencia entre el valor teórico y el experimental del 

voltaje a la salida de la etapa de potencia va aumentando conforme el valor en la 

entrada se va aproximando a 5V. La figura 6.2.4 muestra la gráfica de los datos de la 

tabla 6.2.1, donde se observa que la diferencia se debe a la pendiente de las línea 

recta. 

-9

-6

-3

0

3

6

9

0 1 2 3 4

Entrada (V)

Salida (V)

5

Teórico
Experimental

 
Figura 6.2.4 Comportamiento teórico y experimental a la salida de la etapa de potencia ante 

diferentes voltajes de entrada. 
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En la ecuación 6.2.1 se calcula la pendiente de comportamiento experimental de la 

figura 6.2.4. La cual debió ser de 3.6 tal como se indica en la ecuación (5.2.2) 

 

( ) 535.3
992.298.4

)552.158.8(
=

−
−

=
V
Vm           (6.2.1) 

Esto implica que el error se debe al ajuste de R1 del circuito de la figura 5.2.8. 

Para la identificación del cupón en medición se logran realizar marcas láser de matriz 

de puntos sobre cada uno, tal como lo muestra la figura 6.2.5. 

 
Figura 6.2.5 Matriz de puntos impresa con láser sobre el cupón metálico para su 

identificación. 

El lector de matriz de puntos se instaló con un soporte con varios puntos de ajuste 

(como se observa en la figura 6.2.6) para lograr una ubicación óptima de lectura. 

El sistema de control de posición transporta el cupón en medición por medio de la 

mesa corrediza a una posición establecida, donde el foco del lector apunta a la 

marca del cupón. El lector se activa cuando detecta una marca y envía la información 

a la computadora por el puerto serie. El programa lee del puerto serie en el momento 

requerido. Si no se lee nada del puerto serie, la aplicación desarrollada en LabVIEW 

envía un error que indica que el cupón no fue detectado, igualmente si el cupón ya 

fue leído. 

 76



 

Soporte de lector

Lector 

Foco

Figura 6.2.6 Instalación del lector de matriz de puntos. 
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6.3 Pruebas al sistema. 

Para determinar el funcionamiento del sistema se realizaron 10 verificaciones de 

espesor de flux en diferentes líneas de producción. La figura 6.3.1 muestra los 

resultados almacenados por medio del programa en LabVIEW. 

Para cada medición se utilizaron los mismos cupones siempre en la misma posición 

sobre la bandeja transportadora. 

 
Figura 6.3.1 Pantalla del programa desarrollado que muestra los resultados de las 

verificaciones realizadas de espesor de flux. 

Cada medición se realizó a través del sistema implementado el cual sigue el 

procedimiento especificado en el diagrama de flujo de la figura 5.3.4 y 5.3.5. Los 

datos completos se muestran en la tabla 6.3.1. 
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Después de efectuar la toma de datos con el sistema desarrollado seguidamente se 

efectuó la verificación programando la referencia en un lado del cupón que no 

contenga flux y luego midiendo en el centro donde se encuentra el flux, los datos 

obtenidos por ambos procedimientos se comparan en la tabal 6.3.2, donde: 

De la tabla 6.3.2 se observa que la diferencia que existe entre el procedimiento 

previo y el nuevo (entre 0.0225 y 0.0754 mils) es significativa ya que los valores de 

espesor de flux se encuentra entre los 1x10-2 mils. También se observa que la 

diferencia varía dependiendo del cupón, sin embargo para el mismo cupón la 

variación es mínima (refiérase a la desviación estándar de la tabla 6.3.2). 

Para determinar el porqué de esta diferencia se realizan mediciones de espesor 

sobre los mismos cupones sin flux en el centro del cupón y hacia un lado ante una 

referencia establecida. Los resultados se muestran en la tabla 6.3.3 donde se 

observa que sí existe diferencia y que esta es muy aproximada a la diferencia que se 

presentó e la tabla 6.3.2, por lo que se concluye que la diferencia se debe a que los 

cupones no son completamente uniformes por tanto la importancia de efectuar la 

medición siempre en el centro del cupón lo cual se garantiza con el nuevo sistema. 

Otra prueba fue medir el espesor sobre el flux aplicado en los cupones, en el centro y 

hacia un borde de la capa de flux, los resultados se muestran en la tabla 6.3.4, se 

puede observar que hacia el borde del flux el espesor es significativamente más alto 

(promedio 0.1342 mils) lo que afecta en mayor grado la medición, concluyendo en 

otro importancia de realizar la medición siempre en el centro del cupón. 

 



 

Tabla 6.3.1 Datos obtenidos de 10 verificaciones de espesor de flux por medio del sistema desarrollado. 
Espesor Cupón 1 (mil) Espesor Cupón 2 (mil) Espesor Cupón 3 (mil) Espesor Cupón 4 (mil) Medición Pre Post Espesor Pre Post Espesor Pre Post Espesor Pre Post Espesor 

1 -0.0007 0.8601 0.8608 -0.3750 0.6910 1.0660 0.0344 1.0119 0.9775 -0.0706 0.8467 0.9173 
2 -0.0002 0.7594 0.7596 -0.3421 0.3271 0.6692 0.0639 0.9851 0.9212 -0.0405 0.5788 0.6193 
3 0.0002 0.8422 0.8420 -0.3909 0.5302 0.9211 0.0380 0.9666 0.9286 -0.0773 0.8082 0.8855 
4 0.0004 1.1190 1.1186 -0.3849 0.6774 1.0623 0.0158 1.1883 1.1725 -0.0745 0.9318 1.0063 
5 0.0005 0.7127 0.7122 -0.3784 0.3664 0.7448 0.0252 0.8209 0.8257 -0.0848 0.5475 0.6323 
6 -0.0030 0.9763 0.9793 -0.3833 0.8529 1.2362 0.0159 0.9704 0.9545 -0.0851 0.9259 1.0110 
7 0.0036 0.9537 0.9501 -0.3793 0.7530 1.1323 0.0197 0.9725 0.9528 -0.0791 0.7594 0.8385 
8 -0.0034 0.9617 0.9651 -0.3744 0.8507 1.2251 0.0205 0.9797 0.9592 -0.0738 0.9306 1.0044 
9 0.0008 0.7664 0.7656 -0.3769 0.6211 0.9980 0.0290 0.8056 0.7766 -0.0592 0.7291 0.7883 
10 -0.0037 0.7124 0.7161 -0.3786 0.5206 0.8992 0.0233 0.8808 0.8575 -0.0730 0.8592 0.9322 

 

Tabla 6.3.2 Comparación entre los datos obtenidos por medio del método anterior y el nuevo sistema desarrollado. 
Espesor Cupón 1 (mil) Espesor Cupón 2 (mil) Espesor Cupón 3 (mil) Espesor Cupón 4 (mil) Medición Previo Nuevo Diferen. Previo Nuevo Diferen.. Previo Nuevo Diferen. Previo Nuevo Diferen. 

1 0.8200 0.8608 0.0408 0.9700 1.0660 0.0960 0.9100 0.9775 0.0675 0.8900 0.9173 0.0273 
2 0.7100 0.7596 0.0496 0.6000 0.6692 0.0692 0.8700 0.9212 0.0512 0.5900 0.6193 0.0293 
3 0.7900 0.8420 0.0520 0.8500 0.9211 0.0711 0.8500 0.9286 0.0786 0.8500 0.8855 0.0355 
4 1.0700 1.1186 0.0486 0.9900 1.0623 0.0723 1.1400 1.1725 0.0325 1.0200 1.0063 -0.0137 
5 0.6500 0.7122 0.0622 0.6600 0.7448 0.0848 0.7700 0.8257 0.0557 0.6000 0.6323 0.0323 
6 0.9300 0.9793 0.0493 1.1500 1.2362 0.0862 0.9000 0.9545 0.0545 0.9900 1.0110 0.0210 
7 0.9100 0.9501 0.0401 1.0600 1.1323 0.0723 0.8900 0.9528 0.0628 0.8100 0.8385 0.0285 
8 0.9200 0.9651 0.0451 1.1700 1.2251 0.0551 0.9200 0.9592 0.0392 0.9800 1.0044 0.0244 
9 0.7400 0.7656 0.0256 0.9400 0.9980 0.0580 0.7400 0.7766 0.0366 0.7800 0.7883 0.0083 

10 0.6700 0.7161 0.0461 0.8100 0.8992 0.0892 0.8000 0.8575 0.0575 0.9000 0.9322 0.0322 
Promedio   0.0459   0.0754   0.0536   0.0225 
Des. Est.   0.0095   0.0134   0.0144   0.0148 
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Tabla 6.3.3 Mediciones del grosor de los cupones metálicos en el centro y a un lado. 
Espesor Cupón 1 (mil) Espesor Cupón 2 (mil) Espesor Cupón 3 (mil) Espesor Cupón 4 (mil) Medición Lado Centro Difernc. Lado Centro Difernc. Lado Centro Difernc. Lado Centro Difernc. 

1 0.0600 0.0300 -0.0300 -0.3000 -0.3600 -0.0600 0.1100 0.0700 -0.0400 -0.0500 -0.0400 0.0100 
2 0.0600 0.0300 -0.0300 -0.3000 -0.3500 -0.0500 0.0900 0.0800 -0.0200 -0.0400 -0.0500 -0.0100 
3 0.0600 0.0300 -0.0300 -0.2900 -0.3500 -0.0600 0.1000 0.0600 -0.0400 -0.0400 -0.0500 -0.0100 
4 0.0600 0.0200 -0.0400 -0.2800 -0.3500 -0.0700 0.1000 0.0600 -0.0400 -0.0400 -0.0500 -0.0100 
5 0.0600 0.0300 -0.0400 -0.2700 -0.3500 -0.0800 0.1000 0.0500 -0.0500 -0.0300 -0.0500 -0.0200 
6 0.0700 0.0200 -0.0400 -0.2900 -0.3600 -0.0700 0.0900 0.0400 -0.0500 -0.0300 -0.0500 -0.0200 
7 0.0600 0.0300 -0.0400 -0.2900 -0.3600 -0.0700 0.1000 0.0700 -0.0300 -0.0300 -0.0400 -0.0100 
8 0.0700 0.0300 -0.0400 -0.2900 -0.3600 -0.0700 0.0900 0.0500 -0.0400 -0.0300 -0.0500 -0.0200 
9 0.0600 0.0200 -0.0400 -0.2700 -0.3400 -0.0700 0.1000 0.0500 -0.0500 -0.0400 -0.0500 -0.0100 

10 0.0700 0.0300 -0.0400 -0.2800 -0.3500 -0.0700 0.1000 0.0500 -0.0500 -0.0200 -0.0300 -0.0100 
Promedio   -0.0370   -0.0670   -0.0410   -0.0110 
Des. Est.   0.0048   0.0082   0.0099   0.0088 

 

Tabla 6.3.4 Mediciones de espesor sobre la capa de flux aplicada a sobre los cupones en el centro y en un borde del flux. 
Espesor Cupón 1 (mil) Espesor Cupón 2 (mil) Espesor Cupón 3 (mil) Espesor Cupón 4 (mil) Medición Borde Centro Difernc. Borde Centro Difernc. Borde Centro Difernc. Borde Centro Difernc. 

1 1.0200 0.8000 -0.2200 0.6300 0.5000 -0.1300 1.1400 0.9300 -0.2100 0.9100 0.7600 -0.1500 
2 0.9700 0.8100 -0.1600 0.9000 0.7900 -0.1100 1.3800 1.2500 -0.1300 1.1200 1.0600 -0.0600 
3 1.1900 1.1600 -0.0300 0.8400 0.7500 -0.0900 1.3100 1.2300 -0.0800 1.0600 1.0000 -0.0600 
4 1.0000 0.7700 -0.2300 0.5000 0.4100 -0.0900 1.0500 0.9100 -0.1400 0.7400 0.6100 -0.1300 
5 0.8800 0.6900 -0.1900 0.5200 0.3400 -0.1800 0.9800 0.8300 -0.1500 0.6800 0.5500 -0.1300 
6 1.1600 1.0400 -0.1200 1.0300 0.9300 -0.1000 1.1300 1.0400 -0.0900 1.1200 0.9900 -0.1300 
7 1.0300 0.9100 -0.1200 0.8400 0.7100 -0.1300 1.0500 0.9200 -0.1300 0.9000 0.7200 -0.1800 
8 1.1700 1.0000 -0.1700 1.0300 0.9000 -0.1300 1.1100 1.0200 -0.0900 1.1000 0.9700 -0.1300 
9 0.8800 0.7400 -0.1400 0.6800 0.5800 -0.1000 0.8900 0.7500 -0.1400 0.8300 0.7000 -0.1300 

10 0.8500 0.6700 -0.1800 0.6900 0.4800 -0.2100 1.0800 0.8500 -0.2300 1.0400 0.8200 -0.2200 
Promedio   -0.1560   -0.1270   -0.1390   -0.1320 

 



Capítulo 7  Conclusiones y recomendaciones 

7.1 Conclusiones 

• Por medio de una interfaz de comunicación y un programa computacional se 

logra tener control del dispositivo medidor desde la computadora lográndose 

capturar los datos de la medición. 

• El sistema de control de posición permite colocar el centro del cupón bajo el 

sensor del dispositivo medidor. 

• El sistema de control de posición presenta un comportamiento sub 

amortiguado ante una entrada escalón en lazo cerrado. 

• Por medio del controlador PD diseñado se logra que el sistema se comporte 

de forma más estable ya que se logra disminuir el sobrepaso de un 30% a 

7.5% y el tiempo de estabilización de 1.35 s a 1 s. 

• El sistema no permite mezclar los cupones durante el proceso de verificación 

de flux. 

• Los controles del dispositivo medidor no se requieren manipular lo que le 

permite aumentar su ciclo de vida. 

• Los cupones presentan diferencia significativa en cuanto al grosor en su 

superficie. 

• La capa de flux aplicado sobre los sustratos presenta mayor espesor en los 

bordes que en el centro. 

• El sistema obliga al operario a realizar la medición de espesor de flux de la 

forma correcta, es decir que se realicen las mediciones en el centro del cupón 

antes y después de imprimir el flux. 

• El sistema automatizado garantiza que los datos almacenados en los archivos 

son los valores reales de la medición. 
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7.2 Recomendaciones 

• Diseñar un circuito de seguridad que desactive el sistema ante sobrecargas. 

• Enviar la información obtenida de la verificación a las bases de datos de Intel 

a través de la red. 

• Adaptar un sistema de faja en V para mover la mesa en lugar de la faja 

dentada para lograr mayor estabilidad y tracción. 

• Implementar una etapa de calibración del sistema de control de posición ante 

desajustes, por medio de sensores que detecten los topes de la carrera de la 

mesa corrediza. 
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Apéndices 

A.1 Glosario, abreviaturas y simbología 

Automatización: Tecnología que está relacionada con el empleo de sistemas 

mecánicos, electrónicos y basados en computadores, en la operación y control de 

ciertas labores industriales, administrativas o científicas. 

Bandeja transportadora: Contenedor diseñado para sostener los sustratos. 

CAM: (Significado en inglés Chip Attach Module) es el proceso utilizado para adherir 

el dado de silicio al sustrato. 

Dado de silicio: Pequeña sección de material semiconductor (silicio), conformado por 

varios circuitos integrados. Es capaz de memorizar datos, gestionar información e 

interpretar y ejecutar instrucciones. 

Deflux: Esta operación remueve residuos de flux atrapados entre el dado y el 

sustrato después de la operación de unión del chip. 

DPCS: (Significado en inglés Die Placement Checking System), sistema de revisión 

por medio de cámaras que vigila la colocación del dado para detectar unidades 

desalineadas. 

Esténcil: Una placa metálica con cortes con la forma de las unidades. Se coloca 

sobre el substrato de tal manera que el squeegees sólo aplica flux en el área del 

substrato en el que las unidades van a ser colocadas. 

Flux: Pasta que permite que los puntos de soldadura de las conexiones del dado 

fluyan hacia los pines de soldadura del sustrato cuando se calientan. Además ayuda 

a remover los óxidos y contaminantes que se encuentren en la superficie de los 

puntos de unión. 

GPIB: (Significado en inglés General-Pourpose Interface Bus), bus de interfaz de 

propósito general. 
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IEEE: (Significado en inglés Institute of Electrical and Electronics Engineers), Instituto 

de Ingenieros Eléctricos y Electrónicos. 

Microprocesador: El componente principal de una computadora, a cargo de controlar 

el proceso central de datos. 

Ono-Sokki: Marca del medidor de espesor sin contacto. 

PC: Computadora personal. 

PM: (Significado en inglés Preventive Maintenance routine), es una rutina de 

mantenimiento preventivo. 

Sistema Estático: Sistema en el cual el estado actual depende sólo de las entradas 

actuales (la relación entre las variables está dada por una ecuación algebraica) 

Sistema Dinámico: Sistema en el cual el estado actual depende de las entradas 

actuales y anteriores. Su estado varía con el tiempo y puede ser descrito por 

ecuaciones diferenciales. 

Sobrepaso máximo (Mp): Es el valor pico máximo que presenta la variable controlada 

tomando como base su referencia. 

Squeegee: Parte de la Impresora de flux, que distribuye el flux sobre el Esténcil. 

Sustrato: placa diseñada para proveer conexión mecánica y eléctrica entre el dado 

de silicio y el panel de circuitos de una computadora. 

Tiempo de estabilización (ts): Es el tiempo en el cual la variable controlada alcanza 

su estado estable. 

Tiempo de retardo (td): Es el tiempo en el cual la variable controlada va del 0 al 50% 

de su valor final. 

Tiempo de subida (tr): Es el tiempo en el cual la variable controlada va del 0 al 100% 

de su valor final de una sola vez. 

USB: (Significado en ingles Universal Serial Bus), es un bus serial universal. 
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A.2 Manual de usuario 

La pantalla principal del programa desarrollado para el monitoreo de espesor de flux 

se muestra en la figura A.2.1 

 
Figura A.2.1 Pantalla principal de la aplicación desarrollada. 

El programa cuenta con un menú personalizado el cual se encuentra localizado en la 

esquina superior izquierda de la pantalla principal. En al tabla A.2.1 se resumen las 

funciones del menú. 
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Tabla A.2.1 Descripción de las funciones del menú del programa. 
Ítem Menú Descripción Puede ser accesado 

por: 
File>New measurement Da inicio al proceso de verificación 

de espesor de flux. 
Operador, Técnico e 

Ingeniero. 
File>EXIT Se sale del programa LUNA. Técnico e Ingeniero. 

Operate>Information Despliega una ventana donde se 
presenta en forma de tabla y 
gráfica información sobre el 

historial de mediciones realizadas. 

Operador, Técnico e 
Ingeniero. 

Operate>STOP Detiene el programa. Ingeniero. 
Tools>User>Create Despliega una pantalla para 

ingresar un nuevo usuario del 
sistema a la base de datos de 

usuarios. 

Ingeniero. 

Tools>User>Delete Despliega una pantalla para borrar 
de la base de datos un usuario. 

Técnico e Ingeniero. 

Tools>Product>Create Despliega una pantalla para 
ingresar un nuevo producto y sus 
parámetros a la base de datos de 

productos.  

Ingeniero. 

Tools>Product>Delete Despliega una pantalla para borrar 
de la base de datos un producto. 

Técnico e Ingeniero. 

Tools>Link>Create Despliega una pantalla para 
ingresar una nueva línea de 

producción a la base de datos de 
líneas. 

Técnico e Ingeniero. 

Tools>Link>Delete Despliega una pantalla para borrar 
de la base de datos una línea de 

producción. 

Técnico e Ingeniero. 

Tools>Monitor 
Type>Create 

Despliega una pantalla para 
ingresar una nueva opción para 

realizar la verificación de espesor a 
la base de datos de tipo de 

monitor. 

Técnico e Ingeniero. 

Tools>Link>Delete Despliega una pantalla para borrar 
de la base de datos un tipo de 

monitoreo. 

Técnico e Ingeniero. 

Tools>Calibration Esta opción se utiliza para calibrar 
la posición de la mesa corrediza y 

definir los puntos de paro de la 
mesa. 

Técnico e Ingeniero. 

Tools>Communicate 
with instrument 

Esta opción se utiliza para 
seleccionar el bus de comunicación 

con el instrumento y verificar su 
funcionamiento.  

Técnico e Ingeniero. 

Help>About Muestra información sobre la 
versión de LUNA 

Operador, Técnico e 
Ingeniero. 
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Cuando se selecciona una opción del menú la cual solo puede ser acezada solo por 

ingeniero o técnico, aparece una pantalla solicitando una contraseña (ver figura 

A.2.2). Esta contraseña es asignada a la hora de crear un nuevo usuario lo cual se 

explica más adelante. Si no existe ningún usuario por favor contactar al dueño del 

sistema. 

 
Figura A.2.2 Ventana para el ingreso de la contraseña para tener acceso a opciones de 

menú restringidas.  

En caso de ingresar una contraseña incorrecta aparece el siguiente mensaje de 

error. 

 
Figura A.2.3 Mensaje de error al ingresar contraseña incorrecta. 

Crear un nuevo usuario: 

• Opción del menú: Tools>User>Create 

 
Figura A.2.4  Ventana para ingreso de usuarios del sistema 
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Una vez que se completan todos campos se presiona Ok o Enter: 

• Descripción de los Campos 

Tabla A.2.2 Descripción de los campos de la interfaz para crear usuarios. 
Campo Descripción 

WWID Número de identificación del empleado 
Name Nombre del empleado 
Shift Turno de trabajo (1, 4, 5, 6 o 7) 

Prof Profesión, Ingeniero (ing), técnico 
(MTE) y operario (MS) 

Password Contraseña para cada usuario para 
algunas opciones del sistema 

Retype Password Repetir la contraseña para verificación 

• Tipo de Mensajes después de presionado Ok o Enter 

Tabla A.2.3 Descripción de los errores durante la creación de usuarios. 
Error Descripción 

 

EL número de identificación 
ingresado es inválido 

 

No se ha ingresado el nombre 
del usuario 

 

No se ingresa un número de 
turno correcto  

 

No se ha ingresado la 
contraseña 

 

La contraseña no es igual a la 
contraseña de verificación 

 

El numero de identificación ya 
existe, pregunta si se quiere 
remplazar 
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Borrar usuario 

• Opción del menú Tools>User>Delete 

 
Figura A.2.5 Ventana para borrar usuarios. 

En la cejilla del campo WWID se selecciona el usuario a eliminar y se presiona Ok o 

Enter: 

Crear un nuevo producto: 

• Opción del menú Tools>Product>Create 

 
Figura A.2.6 Ventana para ingresar productos y sus parámetros. 

• Descripción de los Campos 

Tabla A.2.4 Descripción de los campos de la interfaz para crear productos. 
Campo Descripción 

Product Nombre del producto 

Name Event Nombre del evento para la verificación 
de flux 

Target Valor ideal del espesor de flux 
LCL (Low Control Limit) Límite de control bajo 
UCL (Uper Control Limit) Límite de control alto 
LSL (Low Spec Limit) Límite de spec bajo 
USL (Uper Spec Limit) Límite de spec alto 
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• Tipo de Mensajes después de presionado Ok o Enter 

Tabla A.2.5 Descripción de los mensajes durante ingreso de productos. 
Mensaje Descripción 

no se ha completado los campos 

 

El producto ya existe, pregunta si se 
quiere remplazar 

Borrar producto 

• Opción del menú Tools>Product>Delete 

 
Figura A.2.7 Ventana para borrar usuarios. 

En la cejilla del campo Product se selecciona el producto a eliminar y se presiona Ok 

o Enter: 

Crear una nueva línea de producción: 

• Opción del menú Tools>Product>Create 

 
Figura A.2.8 Ventana para el ingreso de una nueva línea de producción. 
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Ingrese el nombre de la nueva línea de producción en el campo Link y presione Ok o 

Enter.  

• Tipo de Mensajes después de presionado Ok o Enter 

Tabla A.2.6 Descripción de los mensajes durante ingreso de líneas. 
Mensaje Descripción 

no se ha ingresado la nueva 
opción para realizar la verificación 

 

LA opción ingresada ya existe 

Borrar línea de producción 

• Opción del menú Tools>Link>Delete 

 
Figura A.2.9 Ventana para borrar líneas de producción 

En la cejilla del campo Link seleccione la línea de producción a eliminar y presione 

Ok o Enter: 

Crear una nueva opción para realizar la verificación: 

• Opción del menú Tools>Type Monitor>Create 
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Figura A.2.10 Ventana para el ingreso motivos para realizar la medición. 

Se Ingresa el nombre de la nueva línea de producción en el campo Link y se 

presiona Ok o Enter.  

• Tipo de Mensajes 

Los mensajes son los mismos que para el ingreso de líneas de producción. 

Borrar opción de verificación de espesor 

• Opción del menú Tools>Type Monitor>Delete 

 
Figura A.2.11 Ventana para eliminar tipos de metos d verificación  

En la cejilla del campo Monitor Tiype se selecciona la línea de producción a eliminar 

y se presiona Ok o Enter: 

Calibración del sistema de control de posición. 

• Opción del menú Tools>Calibration 

Esta opción captura el voltaje del potenciómetro a los extremos de la carrera de la 

mesa corrediza y define la posición de medición, la posición de lectura de la marca 

del cupón y la posición de reposo. Esta calibración es importante ya que la lectura 

del potenciómetro puede variar por algún motivo como descalibración de la faja. 

Consiste primero en una pantalla (Ver figura A.2.12.a) en donde se solicita empujar 

la mesa hasta el fondo para capturar el valor mínimo del voltaje en la terminal 
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variable del potenciómetro al presionar Enter. Seguidamente de presionar Enter se 

cambia el mensaje (ver figura A.2.12.b) para jalar la mesa corrediza hasta lograr el 

valor máximo del potenciómetro. Seguidamente la ventana varía para realizar las 

pruebas y definir las posiciones requeridas (figura A.2.12 c) 

 
Figura A.2.12 Diferentes configuraciones de la ventana en cargada de la calibración. 
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Comunicación con el instrumento medidor 

• Opción del menú Tools> Communicate with instrument 

Esta opción es para seleccionar el puerto donde se encuentra conectado el 

dispositivo medidor y realizar la prueba de que exista comunicación. 

La figura A.2.13 muestra las dos pantallas de la venta, en la primera se muestra una 

cejilla donde automáticamente aparecen los puertos habilitados de la computadora. 

Se selecciónale puerto correspondiente y se presiona Enter 

Seguidamente el programa inicia la comunicación con el instrumento mostrando la 

lectura de dispositivo, si el valor es cero hay que asegurarse de que el dispositivo 

esté bien conectado y encendido. 

 
Figura A.2.13 Pantallas del proceso de verificación de la  comunicación con el instrumento. 
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Realizar una verificación de espesor de flux 

• Opción del menú Tools> File>New measurement 

Al seleccionar una nueva medición aparece la pantalla de la figura A.2.14, la cual es 

para ingresar la información del proceso. La mayoría de la información se ingresa 

seleccionando los datos de las cejillas que se observan en la figura. 

 
Figura A.2.14 Interfaz para el ingreso de la información del proceso. 

Una vez que se han ingresado toda la información aparece un botón (ver figura 

A.2.15) el cual da acceso a la captura de datos. 

 
Figura A.2.15 Botón de acceso a la captura de datos. 

En el momento que se presiona este botón, la mesa corrediza se desplaza a la 

posición de reposo y un mensaje aparece solicitando colocar el cupón en el boquete 

de la placa removible ver figura A.2.16. En el momento que se presiona Enter el 

motor lleva la mesa a la posición de lectura de la marca del cupón se verifica que la 

marca esté correcta y si es así, sigue avanzando hasta la posición de captura de la 

medición de espesor. Si se trata de la primera medición el sistema programa la 
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referencia al dispositivo medidor captura el dato, en las restantes mediciones solo 

captura el dato. 

 
Figura A.2.16 Interfaz para captura de datos. 

Cuando el sistema termina de capturar el dato lleva de nuevo la mesa a la posición 

de reposo, solicita por medio de un mensaje retirar el cupón (ver figura A.2.17) y 

vuelve a iniciar para realizar la segunda medición y así sucesivamente. 

 
Figura A.2.17 Imagen después de captura de datos 
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Cuando se termina de medir los cuatro cupones sin flux, se bloque el programa y 

solo puede ser desbloqueado por medio de la contraseña del operario o por el 

administrador del sistema. La figura A.2.18 muestra el momento del bloqueo. 

 
Figura A.2.18 Sistema bloqueado mientras se imprime el flux 

Después de imprimir el flux y desbloquear el programa el proceso de medición es el 

mismo que sin flux.  

La marca del cupón permite detectar si los cupones corresponden a los previamente 

medidos y ayuda a relacionar las mediciones de cada cupón. 

Después de medir los cupones con flux el sistema calcula el espesor, el promedio y 

la desviación estándar e indica si los valores esta dentro de los límites de control. 

Además gráfica el historial de los datos para la línea y el producto sobre medición. La 

Figura A.2.19 muestra la imagen final de la verificación de espesor de flux. 
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Figura A.2.19 Interfaz final del proceso de verificación de espesor de flux. 

A continuación se muestran los errores generados sobre la detección de la marca del 
cupón. 

Tabla A.2.7 Descripción de los Errores durante la lectura del a marca de los cupones  
Error Descripción 

Si no se coloca cupón o no se 
coloca en la posición adecuada y 
si la marca está dañada 

Cuando se vuelva a ingresar un 
cupón que ya fue leído en la 
misma verificación. 

Cuando durante la medición con 
flux se ingresa un cupón que no 
corresponde a las medidos 
previamente sin flux. 
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A.3 Información sobre la empresa/institución  

A.3.1 Descripción de la empresa [11] 

Corporaciones Intel se fundó en 1968 en el estado de California, EE.UU., para la 

construcción de productos semiconductores de memorias. En 1971 introdujo el 

primer microprocesador, y es hoy en día la mayor productora de procesadores a nivel 

mundial, y un fabricante líder de productos para computadoras, servidores, redes y 

comunicación. 

Los microprocesadores son su principal producto, también llamados las unidades 

centrales de proceso (CPUs), se describen con frecuencia como el "cerebro" de una 

computadora porque controlan el proceso central de datos en los ordenadores 

personales (PC), servidores, y otros dispositivos. 

Esta industria tiene 11 instalaciones de fabricación y seis instalaciones de ensamble 

y de prueba por todo el mundo y cuenta con aproximadamente 80 000 empleados en 

más de 45 países.  

Intel produce el silicio para sus microprocesadores de alto rendimiento, chips y 

memoria flash en las instalaciones de fabricación.  Después de que se construyen los 

productos basados en silicio, se envían a las instalaciones de montaje y de prueba 

de Intel donde cada wafer se corta en 

microprocesadores individuales, se coloca 

dentro de los paquetes externos, y se prueba 

para la funcionalidad. 

Intel Costa Rica pone su énfasis en el montaje y 

la prueba del microprocesador. Inició 

operaciones en marzo de 1998, y en la 

actualidad cuenta con dos plantas de manufactura (CR1 y CR3) para ensamble y 

prueba de microprocesadores, y un centro de distribución (CR2) desde el que se 

envían productos manufacturados en Costa Rica directamente a clientes en todo el 

mundo. En la actualidad emplea aproximadamente 2200 personas. 
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Su campus de 52 hectáreas está ubicado en Belén, Heredia a sólo 10 Km de la 

capital San José y a solo 5 minutos del aeropuerto Internacional Juan Santamaría. 

En Intel Costa Rica también se albergan importantes actividades de desarrollo de 

tecnología en las áreas de software, diseño de microprocesadores, ingeniería de 

productos, materiales y apoyo técnico a clientes finales de toda la región 

latinoamericana así como una amplia gama de servicios tipo 'back office' a clientes 

corporativos alrededor de todo el mundo. 

A.3.2 Descripción del departamento en el que se realizará el proyecto. 

El proyecto se desarrollará en el departamento de ensamble dirigido por Andy Lieu, 

directamente en el módulo de unión de chips (CAM), donde el administrador es José 

Cubero. 

La función principal del módulo CAM es la de unir el chip del microprocesador con el 

sustrato, y de colocar componentes pasivos a los productos que lo requieren como 

los servidores. 

El procedimiento consiste en aplicar suficiente flux sobre los sustratos en la parte 

donde debe ir colocado el dado de silicio, con el objetivo de limpiar la superficie y 

optimizar la unión. Imprimir pasta de soldadura en los espacios para componentes 

pasivos en el substrato. Colocar componentes pasivos en los sustratos en la 

alineación correcta. Colocar el dado sobre el substrato en la alineación correcta. 

Hacer el reflujo a los puntos de soldadura entre el dado y el substrato para hacer una 

conexión eléctrica entre ambos. Hacer un reflujo de la pasta de soldadura entre los 

componentes pasivos y sus pistas para hacer una conexión eléctrica entre ambas. 

Finalmente se quita el residuo de flux del paquete con agua desionizada. 

 102



Anexos 

Anexo B.1 Fotografías del dispositivo medidor de espesor. 

 
Figura B.1.1 Panel frontal del dispositivo medidor de espesor. 

 
Figura B.1.2 Parte trasera del dispositivo medidor de espesor. 

 
Figura B.1.3 Base con los sensores y mesa corrediza del dispositivo medidor de espesor. 
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Figura B.1.4 Cupón metálico sobre la mesa corrediza. 

 
Figura B.1.5 Posición correcta del cupón para realizar la medición. 

 
Figura B.1.6 Vista del dispositivo medidor y la mesa corrediza. 
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Anexo B.2 Comandos de Matlab 

A partir de la función de transferencia como la que se muestra en la ecuación (B.2.1). 

edscs
bassG
++

+
= 2)(          (B.2.1) 

Donde a, b, c, d y e son constantes. 

Cálculo de raíces 

>>roots([c,d,e]) 

Lugar de las raíces 

>>num=[a,b]; 

>>den=[c,d,e]; 

>>rlocus(num,den) 

Respuesta ante entrada escalón 

>>num=[a,b]; 

>>den=[c,d,e]; 

>>step(num,den) 

Respuesta ante escalón en lazo cerrado 

>>num=[a,b]; 

>>den=[c,d,e]; 

>>[numc,denc]=cloop(num,den,-1); 

>>step(numc,denc) 
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Anexo B.3 Hojas de datos 

B.3.1 Convertidor GPIB-USB [4]. 
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B.3.2 Motor de corriente continua [12]. 
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B.3.3 Engranaje acoplado al motor [12]. 
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B.3.4 Potenciómetro lineal de rotación continua [7]. 
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B.3.5 Tarjeta de adquisición de datos [8]. 
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B.3.6 Cámara lectora de código de matriz de punto [9]. 
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B.3.7 Transistor de potencia PNP (A940) [13]. 
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B.3.8 Transistor de potencia NPN (D1138) [14]. 
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